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I. Introduction

Magic Members is a premium Wordpress Plugin that can easily turn your Wordpress blog into
a membership website that is not only fully automated, but also extremely powerful. It allows
you create a variety of different types of membership sites, as well as offering a variety of
different methods of monetization. The best part is that Magic Members is only a single
plugin, which makes integration a snap.

This support guide has been created to walk you through the entire plugin setup, as well as

answer many of the common questions that may arise during the process of installation and
modification. It will also guide you through all of different screens that you will encounter
and what each screen will give you ability to modify.

If there are any additional questions that is not answered in this support guide or on our
website http://www.magicmembers.com, feel free to contact our knowledgeable and friendly
support desk at http://www.magicmembers.com/support. Remember, when you purchased the
Magic Members plugin, you also get unlimited access to our support staff.

II. Installation

1. Permalinks

You need do configure your permalinks before installing Magic Members.
Login to your Wordpress admin area at: http://www.yourdomain.com/wp-login.php
Enter your admin user name and password and hit Enter.
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©) www.wordpress.magicmembers.com/vwp-login.php

ordpress Experts

@WORDPRESS

Username

Password

T Remember Me

Register | Lost vour password?

You will be redirected to Wordpress Dashboard. Then click Settings

[

L C' | (D wordpress.magicmembers.com/wp-admin/index.php

Home

Updates Dashboard

s Posts Right Now QuickPress
[ i :
Media Content Discussion Title
& Links 9 Posts 1 Comment Uploadin
[C] Pages 4 Pages 1 Approved Content
CJ Comments 7 Calegories O Pending
= 0O Tags O Spam
Appearance 9 £
= Tags
5 Plugins v Theme Twenty Ten with 6 Widgets
Installed Plugins Search Engines Blocked Save Drz
Add New You are using WordPress 3.2.1.
Editor
Recent Drafts
& Users
Recent Comments There are no drafts at
T! Tools ~
From Mr WordPress on Hello world! #
Hi, this is a comment To delete a comment, justlog in and view the post's comments. There WordPress Blog

you will have

Software Freedom [
Saturday, September

All | Pending (0) | Approved | Spam (D) | Trash (0} weekend's hackathon
freeze This means it's

enhancements and fix

Incoming Links A Tale of Two Wordi

Then click to Permalinks
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Editor Membership
&, Users
T} Tools

Bl Settings Timezone
General
Writing
Reading
Discussion
Media

Privac
Permalinks

New User Default Role

Date Format

Time Format

Week Starts On

Select an option, except Default

¥ Anyone can register

[ subscriber =]

| UTC+0 | UTC time is 2011-89-17 9:48:16
Choose a cily in the same limezone as you

& September 17, 2011

€ 2011409117

¢ 0911712011

' 17/08/2011

¢ Custom: FjY  September 17, 2011
Documentation on date and time formatting.

@ 9:48 am
¢ 9:48 AM
 09:48

¢ Custom: gia 9:48 am

[Monday =]

@J Links aesthetics, usability, and forward-compatibility of your links. A number oftags are available, and here are some examples to get you star

[0 Pages Common settings

) Comments
fault

Appearance

" Day and name

[ Plugins

Installed Plugins C Month and name
Add New

Editor € Numeric

& Users € Custom Structure
T} Tools 3

Optional

il Settings

General these blank the defaults will be used.
Writing

Reading Category base
Discussion

Media Tag base

Privacy

Permalinks Save Changes

Save the changes

http://wordpress.magicmembers.com/p=123

http:/fwordpress.magicmembers.com/2811/89/17/sample-post/

http://wordpress.magicmenbers.com/2811/89/sanple-post/

http://wordpress.magicmembers.com/archives/123

If you like, you may enter custom structures for your category and tag URLS here. For example, using topics as your category base wc

Note: Your .htaccess file should be writable. You can simply access to your FTP and change
.Jhtaccess file’s access setting to 777

2. Activation

Click Plugins menu at your Wordpress dashboard.
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L C'  © wordpress.magicmembers.com/wp-admin/plugins.php

{2} Dashboard

5 Posts
Media
& Links
[C) Pages

) Comments

Appearance

Users

@ Wordpress Experts

g Plugins Adanew

All (5) | Active (1) | Inactive (4) | Recently Active (2

Bulk Actions =]  Apply

[T Plugin Description

Adminer Adminer (formerly phpMinAdmin) is a full-featured MySQL management tool written in PHP. Thi
Activate | Edit | Delete  yarsion 1.1.0 | By Frank Biiltge | Visit plugin site

Akismet Used by millions, Akismet is quite possibly the best way in the world to protect your blog from
Activate | Edit | Delete staried: 1) Click the "Activate” link to the left of this description, 2) Sign up for an Akismet AP key

Tﬁ Tools Version 2.5.3 | By Automattic | Visit plugin site
Settings [T Hello Dolly This is not just a plugin, it symbolizes the hope and enthusiasm of an entire generation summ
Activale | Edit| Delete  2ndomly see a lyric from Hello, Dolly in the upper right of your admin screen on every page.
3 Gollapss Version 1.6 | By Mait Mullenweg | Visit plugin site
T Maaic Members Maaic Members is a premium Wordpress Membership Plugin that turn vour WordPress blogin

Click to Add New menu
& Links
[ Pages Bulk Actions =| * Apoly
L) Comments [T Plugin Description
Appearance [ Adminer Adminer (formerly phpMinAdmin} is a full-featured MySQL n it tool written in PHP. This plugin include tt

& Plugins
Installed Plugins
Add New

Editor

&, Users

T} Tools

Then Upload;

5 Posts
Media
& Links
Pages

CJ) Comments

Appearance
& Plugins
Installed Plugins

Add New
Editor

&, Users

Activate | Edit[Delete  yargion 1.1.0 | By Frank Biltge | Visit plugin site

[T Akismet Used by millions, Akismet is quite possibly the bestway in the world to protect your blog from comment and tra

Activate | Edit | Delete started: 1) Click the "Activate” link to the left of this description, 2) Sign up for an Akismet API key, and 3) Go to you
Version 2.5.3 | By Automattic | Visit plugin site

[T Hello Dolly This is not just a plugin, it symbolizes the hope and enthusiasm of an entire generation summed up in two word:

Activate | Edit| Delete randomly see a lyric from Hello, Dolly in the upper right of your admin screen on every page.
Version 1.6 | By Matt Mullenweg | Visit plugin site

£% Install Plugins

SearrJI\ Upload | Featured | Popular | Newest | Recently Updated
1

Pluging extend and expand the functionality of WordPress. You may automatically install plugins from the WordPress Plugin Direct

Search

Search for plugins by keyword, author, or tag.

Term | Search Plugins

Popular tags

You may also browse based on the most popular tags in the Plugin Directory:

Select the Magic Members File
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@open x

C)‘C) |_..vFiiev v@]lSeaﬂ:hFde ﬂ
(7]

Organize v  New folder e |
<t Favorit =1 MName - |Datemo&ﬁed |l‘ype |&'ze 1 |
Bl Desktop
& Downloads
15, Recent Places

4 Libraries
|=] Documents

18 Computer
& Windows7 (C:)
= Yeni Birim (Dz)
J FreeAgent Drive (L

2 =l

File name: |magi:members-singie-\.r.l.?.z El IAII Files El

Click install button

{5} Dashboard  Wordpress Experts
b 4 H
& fom £% Install Plugins
Eh Media
@9 Search | Upload | Featured | Popular | Newest | Recently Updated
& Links
[E] Pages
Install a plugin in .zip format
CJ Comments

Ifyou have a plugin in a .zip formal, you may install it by uploading it here.
@ Appearance Choose File magicmember...v.1.7.2.zip Install Mow
e

Installed Plugins
Add New
Editor

Tip: Please check your PHP upload limit. Make sure it's higher than Magic Members' file size.

Then you will see “Plugin installed successfully.” message. After that please click the “Activate”
link.
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(3} Dashboard (@ Wordpress Experts
5 Posts
Media

Installing Plugin from uploaded file: magicmembers-single-v.1.7.2.zip

Unpacking the package...

& Links

Installing the plugin...
[l Pages !

Plugin installed successfully.
CJ Comments

Activate Plugin j Return to Plugins page

Appearance

& Plugins

Installed Plugins
Add New

Editor

J-' B P

You will see a menu on your Wordpress sidebar called Magic Members. Click to Magic
Members menu button to access the license activation menu.

5 Posts .(_é;% i 2

Lo £ Plugins #dd niew

25 Media

Plugin activated.
‘p Links ——————
L) Pages
AlE(5) | Active | Inactive (4) | Recently Acthve (2
5 C
| Bulk Actions =l Apely
[ Appearance
I Plugin Deseription

& Plugins

Instalied Plugins ™ Adminer Adminer (formerly php in} is 3 full-featured MySQL tool writlan in PHP. This plugin include thig tool in WordPress for a fast managen
Add New Activate | Edit| Delete  yarsion 1.1.0 | By Frank Baltge | Visit plugin site

Editor T Akismet Used by millions, Akismet is quite possibly the bestway in the world to protect your blog from comment and trackback spam. I keeps your site protech
Qg seia Activats | Edit] Delete started: 1) Click the “Activate” link to the left of this description, 2) Sign up for an Akismet AP/ key, and 3)'Go fo your Akismet configuration page, and save y

Version 2.5.3 | By Automattic | Visit plugin site

T} Tools

— T Hello Dolly This is not just a plugin, i symbolizes the hopa and enthusiasm of an entire generation summad up in twa words sung most famously by Leuis Armstron
17| Settings Activate | Edit| Delete  f@Nd0mly see a lyric from Hello, Dolly in the upper right of your admin screen on every page.

e \arsion 1.6 | By Matt Mullenweg | Visit plugin site
, Magic Members i 2

™ Magic Magic i5 3 premium P Plugin that e your WoraPress Biog into a powerul, fully aulomated membership site

Deactivate | Edit Version 1.7.2 | By Magical Media Group | Visit plugin site

You will need to activate Magic Members with your Purchase e-mail address. Your purchase
e-mail address is your activation key.

{5t Dashboard @ Wordpress Experts

s Posts

3 Media @ agichlembers Activation
& Links A

1] Pages

o
CJ Comments Magic Members Activation =]
; & Magic Members

E Appearance

© Pugin BBt o S NS o s i
Q\‘_"\ Users if you dont have a key then please visit hitp www magicmembers.com to purchase one

T} Tools I Registration Email: Activate I

[#7] Semings

agic Me

Ac||ivale with your purchase email

You’re ready to use Magic Members.
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You need to check the pages from; Wordpress Dashboad - Pages

Eh Media - Title
2 Links o Login
All Pages T Lost Password

Add New

B Commants M Membership Details

[& Appearance I Profile
£ Plugins
&, Users T Register
T} Tools
T Transactions
[f7] Settings
Magic Members N Title

Bulk Actions =l Apply

Author

admin

admin

admin

admin

admin

Author

Tips: If the pages are not created automatically, you need to create them manually with short
codes. You can find the related short codes at Magic Members --> Misc. Settings --> General

Settings --> Custom URL Settings.

When you install Magic Members, system creates some pages automatically such as; Login,

Register, Transactions, Lost Password, Profile..

Magil:Men'dlm
acabritas emsimsae v
- Magic Members Dashboard
& Magic Members

& Members

Dashboard

L Qe

Plugin Messages
; Content Control

MGM V.1.7.1 Changelog
091072011
-fixed- Pay Per Post listing on admin side

Pay Per Post

¢ Payment Settings

MGM V.1.T Changelog

09/08/2011

-added- New setting to the subscription packs - when
expired/cancelled, move members to -

-fixed- Status widget

-improved- Import users. Limited the upload for 2000 users at a time

L& Misc. Settings

&* Tools

|=| Support Docs
MMV 1 R W Channalan

@3
@
Version Check
Current version: 1.7.2
You are using latest version
@

Magic Members Hews

MGM V.1.4 Released

Hi gveyone! We released the new version of Magic Members, Here's what's new in
the plugin: Getresponse Autoresponder Integration MsilChimp Autorsspandes
Integraticn Effective Custom User Fields Fully Featured Online Video Helpers

Mo nnmainm Hodain A7 4 4

Make sure they're set correctly. You need to check the pages at; Magic Members = Misc.

Settings = Custom URL Settings
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Q3

Payment/Subscription Settings

Select the Currency which will be used for the payments:

USD - U.S. Dollar =]

g/ All Payment transaction currency

Your Subscription Name:

‘Wordpress Experts Subscription

&/ The name of the membership to display on the order form.
Use [blogname], [membership] (ags to sat blogname and membership respectivaly.

Register URL:

hitp:iiwordpress.magicmembers.comiregister

v Custom Register URL for regsiter and related actions. This URL is meant to be updated insige your site, you can creste a8 Wordpress postipage and
peaste the page url here.
Tag:
[user_register] - Shows Register Form

Profile URL:

hitp:iiwordpress.magicmembers.com/profile

g Custom Profile URL for profile and related actions. This URL is meant to be updated inside your site, you can create 8 Wordpress postipage and paste
the page url here.
Tag:

III. MAGIC MEMBERS MANUAL

1. Magic Members Dashboard

+ Magic Members

= Dashboard

Activate Maogic Members

The Magic Members Dashboard is the screen that you will see every time that you open the
Magic Members plugin. It is designed so that you will be automatically provided with some
basic information such as member statistics, purchased posts, version checks, and much more.

Page 15



1.1 Plugin Messages

Plugin Messages a ﬁ

MGM V.1.4 Released

The Plugin Messages sections allows you to view your license type. It will also share any
recent updates about your license type, as well as remind you what version number you are
using.

1.2 Version Check

@

Version Check

Currentversion: 1.7.33
You are using latest version.

It is important to always keep an eye on the Version Check area. It will let you know what
version you are using, as well as the most updated current version available. If you are not
currently using the most up to date version, an update button will appear. The update button
makes it easy for you to download and install the latest version of Magic Members.

1.3 Magic Members Subscription Status

Magic Members Subscription Status @ .

Your Subscription expires on 23 Feb, 2011.
Extend your subscription.

Your Magic Members Subscription Status will let you know when your plugin's free upgrade
expiration date is. Remember, free updates are only available for the first year.

Fortunately, you can extend your subscription by clicking on the “Extend” hyperlink. This
will take you directly to the service renewal page, which will make extending your
subscription easy and fast.

1.4 Magic Members News
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Magic Members News a ﬁ

MGM V.1.4 Released

Hi eveyone! We released the new version of Magic Members. Here's what's new in the
plugin: Getresponse Autoresponder Integration MailChimp Autoresponder Integraticn

Effective Custom User Fields Fully Featured Online Video Helpers ...

Upcoming Update V.1.1

Hi eveyone! We are really exited about the new version of Magic Members. Hare's
what's new in the plugin: Awaber Autoresponder Integration Authorize. Met Payment
Integration Integrated WY'SIWY'G (What You See Is What YVou Get) editor will help
you customize your emor, warning and other messages Mew “Wellcome™ mail editor

which will let you specify the mail you want to send [...]...

The Magic Members News section is a feed of announcements. It will give you access to any
important news related to using the Magic Members plugin. This includes news about recent
updates and new versions that have been made available for download.

1.5 Purchased Posts

Purchased Posts (last 5) @ ﬁ
Post Title Purchased
Weird Post 1

WView All »

The Purchased Posts section will show you the 5 most recent posts that a viewer has bought.
This section will only tell you the title of the post, as well as the number of times that it has
been purchased.

For more comprehensive and detailed information, click the “View All” link at the bottom-
right corner. It will provide additional information including: price that was paid for the post,

a short description, and the date that it was created. This area can also be found by clicking
on the Pay Per Post section and then clicking on the PPP Packs tab.

1.6 Members Statistics
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Member Statistics a Ei

Account Type Users
Guest

Trial

Free 2
Silver 22
Gold

basic 0

The Members Statistics section will show you all of the account types that you have created,
as well as how many members that each account type includes.

1.7 Magic Members Blog

Magic Members Blog a |:i

Magic Members Keeps Your Members Coming Back for More
Magic Members — Simplifying Membership Management

Use Magic Members to Maximize Your Membership Profits

Use the Magic Members Plugin to Create Passive Income

Magic Members Gives You Complete Contral Over Your Members

This section is a live feed from the Magic Members Blog, which can also be found at
http://www.magicmembers.com/membership-plugin/.

2. Members

= Members

This section is accessed by clicking on “Members” button. It has three separate tabs:
Members (2.1), Subscription Options (2.2.), and Coupons (2.3).

2.1 Members ===> Members
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= Members = Subscription Options = Coupons = Roles & Capabilities

2.1.1 Advanced Search

Advanced Search ﬁ
PageNo: 1 [7] Records Per Page: 20 [=]
Search By | Select [=] SortBy: | Usemame [=] asc [] [ show 2

Username User D @ d
Registered| UseriD User Email

User Email Registration Date

First Name

Last Name
Membership Type
Registration Date
Last Payment
Expiration Date
Fee

Status

The Advanced Search feature allows you to filter you member list using the criteria that you

specify.

e Page = The page that you want to view

e Rows Per Page = How many members that you want to view per page. If you make

this number too large, the load time will be greatly increased.

e Search By = You can filter the results by username, user ID, user e-mail, first name,
last name, membership type, registration date, last payment, expiration date, fee or

status.

e Value = The blank box after “Search By”. This is where you enter the value that you

want to search by.
e Sort By = This controls how the list will be sorted and has couple of options like
username, user ID, user e-mail and registration date.

e ASC/DESC = Choose whether you want the list shown in ascending or descending

order.
e Reload Icon = It will refresh the member list without reloading the whole page.

Example: You want to find all of your members that have a username with “John” in it and

want to view the results based upon the order of their payments in ascending order.
Filter By = Membership Type

Value = Gold

Sort By = Registration Date

ASC/DESC =ASC

Once you have entered all of the variables, hit reload and you will get your results.
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2.1.2 Registered Members

[ User[1D] Membership
i -
[C  blogtest[67] .
blogtest@blogtest.com
blogtest
[Tl brent1[31] i

Package

Gold - 100
LISD per 3
months -
Ongoing

20th Feb 2012

Register

20th Feb 2012

Gold - 5.00 REGISTER:

UsSD per1
maonth -
Ongoing

10th Mov 2011

05th Jan 2012

EXPIRY: 29th
May 2012

Dec2012

Status

Active

Last payment was
successiul
¥: 29th Feb 2012

CUSTOMERID: 0

REBILL 1D: 1327785

Active
Last payment was refunded
LAST PAY: 11th Dec 2011

Once you have filtered all of the members in the Advanced Search, this area will is where you
will find the results. It is right below the Advanced Search area. If you do not do an
Advanced Search, this area will be sorted by Status as a default.

The results that you will find in this area includes:

e User (ID) = The username and email address of the member

e Membership = Name of the membership the member has signed up for

e Package = The subscription pack type that the member purchased. It is displayed as
the price and length of the membership. It also displays the Pack Join date.

¢ Register = Displays the Registration Date.

e Expiry = Displays the Expiration Date.

e Status = Displays the status of the user's membership. Active, Inactive, Expired or
Pending. It also displays and the Last Date of Payment and the transaction number.

2.1.3 Update User Accounts
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L=

Update User Accounts

Please select some users from the list above to apply the update(s):
[[] status: Select
[[] Membership Type: Select
[F] Expiration Date:

[ Hide Private Content No

Prior to Join:
[] Subscription Pack: Select

Apply as new subscription Do not update expiration date Highlight this packs's role
Update =

This area allows you to either update all of the displayed members at once or one at a time. If
you want to only alter one or a select few, then manually select them by adding a check mark
next to their information (in the Registered Members area). In this area you can change the
followings:

o Status = Status of the subscription pack. It can be Active, Inactive, Expired, Pending
or Error

e Membership Type = You can change the user's membership type based upon the
membership levels you created

e Expiration Date = You can set the user's subscription's expiration date by
day/month/year

e Hide Private Content Prior to Join = If you want your member to access to the
content that are published before his registration date, you can set this to yes.

e Subscription Pack = You can change the user's subscription pack with this selection.
Rebill cycle, expiration date and everything else that the subscription pack has will be
applied to the member. This option has additional 3 options:

o Apply as new subscription = This will add the subscription pack to the user as
an extra. So, user will have 2 subscription pack for his account at the same
time. This will only work if you enable multiple subscription purchase options
at Magic Members --> Misc. Settings --> General

o Do not update expiration date = If you select this, the expiration date won't
be updated for the selected subscription pack.

o Highlight this pack's role = If you select this the Role that the subscription
pack has will be applied to the user.

Once you are ready, simply click the “Update” button.
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2.1.4 Export User Data

L

Export User Data

Membership Type: All L
Membership Expires: Days %
Date Range: Start: End

[] Exclude Expired Users

Export »

This area allows you to export all of your member data as an XLS file. You can customize
this data in several ways.

e Membership Type = Select the corresponding membership type from the drop-down
box. As a default, all types will be exported.

e Membership Expires = Select only members that expire in a certain number of days,
weeks, or months.

e Date Range = You can select a membership duration by setting Start and End dates.
e Exclude Expired Users = Check the box if you don't want to export the expired users.

2.2 Members ===> Subscription Options

= Members = Subscription Options = Coupons + Roles & Capabilities

This is the area that you can add, delete, or modify the subscription types that your
membership site will offer.
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L I

Membership Types

Membership Type Delete
Guest System defined.

[ Login Redirect URL:

[ Logout Redirect URL:

Trial System defined.

[ Login Redirect URL:

[ Logout Redirect URL:

Free System defined.

[ Login Redirect URL:

[ Logout Redirect URL:

Silver [[] Delete and move this membership type's members to

—none—
[ Login Redirect URL:

[ Logout Redirect URL:

New Membership Type. (250 Characters max.)
Login Redirect

Logout Redirect

@' Flease provide a new Membership Type and click on update. Please do not use any special characters in Membership Type name.

Update =

2.2.1 Creating a New Membership Type

In order to create a new Member Account Type, simply enter the name of the membership that
you want to use, and click the “Update” button. In the picture above, you can see that Guest,
Trial, and Free have already been created by the system and cannot be deleted. When you
create a membership level, you can also set their Login and Logout redirection URLs.
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2.2.2 Deleting a Current Membership Type

If you want to delete an account type, check the box where it says "Delete and move this
membership type's members to" choose what account type that you would like the current
members to be transferred to and click the “Update” button.

2.2.3 Creating and Editing Subscription Packages

When you click on the tab of the membership type that you want to modify, you have a
number of options/settings to choose from.

Membership Type = This ties the Pack to the Membership Type

Duration = Can be in days, months, or years

Cost = Total price per billing

Billing = This states how many times a membership type will be re-billed. If it is
endless, then choose “Ongoing”.

Role = This defines the users role designation. Just like with a default ~ Wordpress
installation your options are “subscriber, administrator, author,  editor, and
contributor.

Default = If selected Yes, the subscription pack will be selected as default
Description = Description of the subscription pack. It will be displayed under the pack
name and the price.

Hide Private Content Prior to Join = If selected Yes, members can access only the
content which are published after their registration date.

When expired/cancelled, move members to = If selected, member's will be assigned
with the selected pack when expired/cancelled.

Active on = You can decide where you want this pack to be displayed. Register page,
Upgrade page and Extend page

Hidden? = If you deselect all the options on "Active on" and enable " Hide on General
Registration" option, your pack will be hidden and will be accessed only with a
specific link.

Sort Order = Type the order number. With this section you can re-order your
subscription packs

Use Trial = If your payment gateway supports, you can use Trial

Use Module = You can activate the payment gateways that you want to use with this
subscription pack.

Custom URL = This is the subscription pack specific registration url

Wordpress URL = This is the subscription pack specific default registration url

Tag = This is the subscription pack specific registration shortcode
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Package #4

Basic Settings

Membership Type : Silver |Z|
Duration : 1 Month |Z|
Cost : 1

Billing : or1going|3

Role ; Subscriber E
Default : No |Z|

Description

Silver Membership

Hide Private : No |Z|
Caontent Prior to
Join o' If selected Yes, members can access only the content which are published after their registration date.

When : None |Z|
expired/cancelled,

move members to & If selected, member's will be assigned with the selected pack when expired/cancelled.

Display Settings

Active on : Register page Upgrade page Extend page
Hidden? : Hide on General Registration
Sort Order

Trial Settings

Use Trial : No |Z|

Payment Settings

Allow Renewal : No |Z|
Use Modules : Paypal Standard ¥ Authorize.Net [[] iDEAL [[] Free [[] Paypal Pro [ WorldPay

Package Register URLs/Tag

Custom URL :  http://wordpress.magicmembers.com/register?package=c2lsdmvylzQ
Wordpress URL : http://wordpress.magicmembers.com/wp-login.php?action=register&package=c2lsdmvyizQ
Tag . [user_register package=silver#4]

Delete Package »
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2.3 Members ===> Coupons

= Members = 3ubscription Options = Coupons

2.3.1 Coupon List

Coupon List

ID# Code Value Desc.

2 platinum sub_pack_tria#3_M_0_1 platinum
Amonths
free

- | silver sub_pack#0_1_Y_silver 1 use silver

Use Limit

Unlimited

0of 1used

= Roles & Capabilities

Expire

MNever

Never

Create Dt.

2710212012

14/02/2012

Action

Edit
Delete

Users

Edit
Delete

Users

The Coupon List area shows you all of the current coupons that you have running. The

information includes:

e ID = Coupon identification number within Magic Members
Coupon Code = This is the actual code that users must enter in order to receive the

discount.
Value = This is the coupon setup value

Delete = Delete coupon from the list

2.3.2 Adding a Coupon
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Description = This is for your own purposes, so that you know what each coupon is.
Use Limit = If you set a usage limit for the coupon, you'll see it here.
Create Dt. = Date that the coupon was created and made active

Edit = Allows you to edit current coupons

Users = This button will allow you to see a list of users that have used the coupon.



Add Coupon

Code :

Value :

Description :
Usage Limit: Unlimited?
Expire Date =

Save »

In order to create a coupon, simply enter the Code, Value, and a short description. If you want
to limit the usage, set a number. You can also have an expiration date for your coupon. A fter
that hit the save button. Keep in mind the description is for your own purpose, so make sure
that it is easy for you to understand.

2.4 Members ===> Roles & Capabilities

= Members = Subscription Options = Coupons = Roles & Capabilities

This is the area that you can add, delete, or modify the User Roles that your subscription pack
can have.

2.4.1 Creating a New Role
Just enter a name at the section called Role, then select the capabilities that the role will have.

After that click the "Add" button.

3. Content Control

B Content Control ‘
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3.1 Content Control ===> Protections

= Protections = Downloads = Pages = Custom User Fields

3.1.1 Full Content Protection Settings

= I

Full Content Protection Settings
Would you like to hide all of your content?

Content Protection 7 FULL @ PARTLY ©) NONE

‘Word limit for public access: 0

Allow HTML or Text in partly protected content: @ Allow HTML ) Text Only
)
Protect your contents
FULL = Protects contents automatically All Contents will be protected and users have to login before viewing. [private] tags added manuslly will be honored.
PARTLY = Protects contents automatically. Part of the content will be free and rest will be viewable after login. [private] tags added manusally will be honored.

NOME = Mo protection will be applied. Any settings in postipage sefup and [private] tags added manually will be disregarded unless postipage is set as
Purchasable.

Purchasable Post will require login (unless guest purchase is enabled) irrespective of Content Protection seftings.

Extended Content Protection:
Hide Content By Membership? () Yes @ No

&
Controls whether postsipage are hidden by current user membership typs.

First part is about the Content Protection and its automation.

FULL = Protects contents automatically. All Contents (pages and posts) will be protected and
users have to login before viewing any part of the content. If [private] tags are used manually,
system will apply the manual settings.

PARTLY = Protects contents automatically. Part of the content will be free and rest will be
viewable after login. You can set a word limit where it says “Word Limit for Public Access:”

If [private] tags are used manually, system will apply the manual settings.

If you select the Word Limit to 0, you will enable the manual protection mode. You will have
to enter [private][/private] tags to your posts/pages manually.

NONE = No protection will be applied. Any settings in Post/Post Setup and [private] tags
added manually will be disregarded.

Note: Purchasable Post will always require login irrespective of Content Protection settings.
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Second part is about extending the Content Protection.

If you select “Yes”, any content which is protected by [private] tags or with automated
protection will not be available to public access. If someone tries to access the link, they will
see a 404 error page. This means that the content will also be hidden from the search engines
as well as visitors that are not logged in. Many people choose “No” because they want to have
some teaser content that everyone can see.

3.1.2 Private Tag Redirection Settings

QU

Private Tag Redirection Settings

You can use the following options to override the no access messages normally shown between [private][/private] tags.
No access URL for logged in users

@/ (Don't forgst to type HTTP if it's an external link)
No access URL for logged out users

@ (Don't forgst to type HTTP if it's an external link)

Would you like to redirect users on (O Yes (& No
homepage?

If you decide to use private tags in your content, then visitors that do have access to it, will be
shown an alternative message. However, you can also redirect them to another page as well
(such as a sales page or splash page).

The first box is used to redirect the visitors if they are logged in, however do not have access
to the content. Normally this is because they have a membership that is not all-access.

The second box is used for visitors that are not logged in at all, and may not even have a
membership.

If you simply want to redirect everyone to your homepage, you do not need to fill in these two
boxes, but rather just click “Yes” at the bottom this area. If you ARE using custom redirects,
make sure that you click “No”.

3.1.3 RSS Token Settings

R55 Token Settings

Activate RSS Token - If selected "MO”, full content view in RSS feeds will be disabled for members only content.
i@ Yes ) Mo
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If you click “Yes”, then members who have access, will be able to view the entire content of
the RSS feed. If you select “No”, they will not.

3.2 Content Control ===> Download

= Protections = Downloads = Pages = Custom User Fields

3.2.1 All Downloads

QL

All Downloads

1] Title File Limited File Exists? Expires Posted Action
Access

1 test 33670000.jpg Yes Yes Never December 27, Edit

2010 by admin Delete

Add New Download =

This area will give you, your full download list. They can be added to posts or just left in a
“Downloads Area”. All of the links will be encrypted so that they cannot be accessed directly.

ID = The ID number of the download

Title = The title that you give the download

File = The actual file name

Limited Access = Whether or not it is encrypted

File Exists? = This tells you whether or not the download can be found on your server
Expires = If you set an expiration date for your download files, it will be displayed here
Posted = This is the date that you created it

Action = This is where you can edit or delete the download

3.2.2 Adding a New Download
In order to add a new download, you need to fill in all of the following information.

e Title = Title that you give the download

o Upload File = This allows you to directly upload it from your computer or you can
enter a Direct URL if it is already on your server. Files need to be uploaded to
yoursite.com/wp-content/uploads/mgm/downloads/

e Restrict Access = This allows you to restrict access to the download based upon your
selections. This means that once you select where you are going to place it, Magic
Members will determine the appropriate level of access automatically.
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e Expire Date = If you enter a date, file download will be available until the sate you
enter. Then, download will expire.

Once all of this is done, simply click the “Save Download” button

In order to use the download file you add in your posts/pages, note the ID (ex:1) then add it
as:

[private][download#1][/private]

Then select the membership level to access and publish your post/page. Your download link
will show as http://www.mysite.com/download?code=4ca61f191152d

Add Download
Title
(required)
Upload a file I Erowse..
Direct Url:
Restrict ers of the appropriate access level can access the file. User level is calculated by checking access to 2
Access?
About
Forum
Hello world!
Our Word Limit Test
Page Test
protection test
Selling this
testing
Transaction
Expire Date 03/321/2011
Save = « Cancel

3.3 Content Control ===> Page

In here you see your page list. If you use Wordpress' page view codes and don't want some of
your pages to show on your membership site, you can click the ones you want to leave out,
then click “Update Excluded Pages”.

Page Exclude Settings

About
Products Page

[[] Checkout

[[] Transaction Results
[T] Your Account

[ Forum

[£] Forum

Update Excluded Pages



3.4 Content Control ===> Custom User Fields

= Protections = Downloads = Pages + Custom User Fields

3.4.1 Create Custom Registration/Profile Fields

Add Custom Field
Label :
Name :
g default lowercase label value, spaces replaced by underscore.
Input Type - Text Field (Single Line) [+ ]
Settings : N )
[ Required!
[ Readanly
[[] Hide Label
[[] 8end to Autoresponder
[[] Capture Only
[[] 8how On Register Page
[F] 8how On Profile Page
[[] 8how On Payment Page
[F] 8how On Public Profile Page
& Seftings for the frelds.
53'\-'9 =

The custom fields that you create in this area will be used on your registration and/or your
profile form.

e Label = This is the name of the field that will be displayed (such as gender, phone,
number, age etc.)

e Input Type = Text Field (Single or Multi Line), Drop Down Menu (if selected, an
“Options” box will appear for you to set your dropdown menu), Checkbox, Radio and
Hidden Field (to hide the autoresponder box)

e Value = You can assign specific values or just leave it blank. If you leave it blank,

anything that is entered by the user will be accepted.

Required! = Field should be filled in order to continue registration.

Readonly = Field will be read only. So, users can't modify the field, but admin can.

Hide Label = If you want to hide the label of the field, check this box.

Send to Autoresponder = If you want to match the fields with your autoresponder,

select this one.

e Capture Only = If selected "Field Alias:" option will appear. You can use this to
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match your buddypress fields with Magic Members fields.

Show On Register Page = Click this if you want to display the field on the
registration form.

Show On Profile Page = Click this if you want to display the field on the profile
form.

Show on Payment Page = This is used to send data for credit card processing (only
for PayPal Pro, Authorize.Net and Eway)

Show On Public Profile = Click this if you want to display the field on the public
profile form.

Once you are completed, click the “Create Custom Field Button”

3.4.2 Magic Members Custom Registration Field

Custom Registration Fields e ﬁ
Active? Label Name/ID Type Others Action
& Subscription Introduction subscription_introduction label Show Edit | System
7l Subscription Options subscription_options label Show Setup Edit
] | would like to receive updates. autoresponder checkbox Show Setup Edit
7l Address address textarea Show Edit Delete

This area is important after you have already created custom fields.

Active = If it is checked, the field is active

Label = Name of the Field in registration page

Name = Name of the Field in the database. This name will also be added to the css
class for the field.

Type = This is input type that you selected when you created the field

Others = It shows the other datas:

e Required = Whether or not users MUST fill it out

Read Only = Meant to be read and the user doesn't have to enter any information
Hide Label = If “Yes”, the field's label will be hidden in the registration form
Send to Autoresponder = If “Yes”, the field's data will be sent to the
autoresponder.

Register = If “Yes”, the field will be shown in the registration form

Profile = If “Yes”, the field will be shown in the user profile page

Payment = If “Yes”, the field will be sent to Payment Gateway

Public Profile = If “Yes”, the field will be shown in the public profile page
Action = These buttons allow you to either edit, delete or setup the custom field
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4. Pay Per Post

B Pay Per Post ‘

4.1 Pay Per Post ===> PPP

» PPP » PPP Packs

4.1.1 Purchased Posts

Purchased Posts e d
Post Title Purchased
Weird Post 1

This area will show you the title of every post that has been purchased. You will be shown the
title of the post and how many times that it has been purchased.

4.1.2 Post Purchase/Gifts

L I

Post PurchaselGifts

Member Post Type Expire Date Purchase/Gift Date Action

Batman IMarketing Tricks Purchase Indefinite 12M10/2010 Delete
July 2010 Issue

This area will show you several pieces of information

Member = The username of the person who purchased the post

Post = Title of the purchased/gifted post

Type = Type of the post. Purchase or gift.

Expire Date = How long the user can view the post

Purchase/Gift Date = Date of the purchase or gift

Action = You can delete the separate purchase record. This will not delete the record
of the purchase from other areas of Magic Members reports, it essentially erases it
from this area and will not affect the ability of users from viewing the post.
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4.1.3 Gift a Post or Page

@n

Gift a Post/Page

Picka User: blogtest E
Select a postipage: Marketing Tricks August 2010 Issue E
[F] override PPP expiration date

Send Gift

This section allows you to give away a post as a gift to your users.
e Pick a User = This is a drop-down menu that has all of the users that you can choose
from
e Select a Post/Page = This is a drop-down menu that has a list of all of the posts and
pages that you can give as gifts

Once you are done, simply hit the “Send Gift” button.

4.2 Pay Per Post ===> PPP Packs (Pay Per Post Packs)

« PPP = PPP Packs

4.2.1 Whatis a Pack?

You already know that you can sell posts and pages individually, but you can also create a
pack of posts. Normally, you create a pack comprised of several posts and pages and sell
them at a price that is lower than purchasing the posts separately

4.2.2 Creating a New Pack
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Create a New Pack

MName :

Cost: uspD

Description :

Save s

Creating a new pack is simple, you just need to fill in these three lines and hit “Save”
e Name = This is the name of the Pack and it will be displayed to users

e Cost = Total price of the pack
e Description — A short description of what the pack is or what it offers

4.2.3 Managing Your Packs

@
Post Packs d

ID Shortcode Name Cost Description Date Action

Created
1 [payperpost_pack#1]  Marketing Tricks 25USD 3lssues of 1210/2010 Edit Delete 3 Posts
sSummer Pack Marketing Tricks
Magazine.
2 [payperpost_pack#2] Test 23UsD this is test 1510212012 Edit Delete 0 Posts

On the Pack page, you will first be given some basic information about packs that you have
already created. This includes the ID number, the shortcode for you to sell the pack, name,
cost, description, and date of creation. You also have 3 actions that can be taken.

e Edit = The edit button is only used to edit the information, not the posts that are
included in the pack.

e Delete = Delete the entire pack

e (0 Post = The first action button is the one that you will use to actually add posts and
pages to the pack. If there are no posts/pages in the pack, then the button will say “0
Post”, if there are 5 posts in the pack, it will say “5 Post” and so on.
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4.2.4 Adding Posts to a Pack

- N @
Posts within Pack Marketing Tricks Summer Pack
Post Title Date Added Action
Marketing Tricks August 2010 Issue 12/10/2010 16:13 Delete
Marketing Tricks July 2010 Issue 12102010 16:13 Delete
Marketing Tricks June 2010 Issue 12110/2010 16:13 Delete
- 0n
Post to Pack Association
Add new Posts to this Pack
Post: Some Guest Post Purchase [=] Save »

& This dropdown will populate with posts as you mark them as purchasable

= Back to Post Packs

Once you click on the “0 Post” button, you will see the above screen. The first area shows the
list of posts that are already included.

In order to add a new post to the pack, you want to choose another post from the bottom area.

There will be a drop-down menu that contains all of the posts and pages that you could add to
the pack. Once you choose the post, simply hit the “Save” button.

5. Payment Options

# Payment Options

5.1 Payment Options ===> Paypal Standard

= Paypal Standard = Payment Modules

-

Paypal Standard Settings

PayPal Standard module supports;
1. Subscriptions
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2. Trial Subscriptions
3. Single or Multiple Post Purchases using PPP and PPP Pack

5.1.1 Enter Your Paypal Email Address

You will need to enter here your PayPal Business e-mail address.

Paypal Business Email:

paypal@magicmembers.com

g’ Paypal primary email where the payment will be sent.

5.1.2 PayPal API Details

Paypal APl Username:

oY Paypal APl Username Provided by Paypal.
(If provided, User Subscription cancellation will be done internally hence the User doesnt need to visit PAYPAL site to cancel
subscription. }

Paypal APl Password:
& Paypal APl Password Provided by Paypal.

(If provided, User Subscription cancellation will be done internally hence the User doesnt need to visit PAYPAL site to cancel
subscription. }

Paypal API Signature:
& Paypal API Signature Provided by Paypal.

(if provided, User Subscription cancellation will be done internally hence the User doesnt need to visit PAYPAL site to cancel
subscription. }

You'll need to fill the API details if you want your users to unsubscribe within your site
without going to PayPal. This will also help your customer to upgrade to their subscription
pack by automatically unsubscribing from their previous subscription pack.

5.1.3 Select The Currency Used For Payments

The Currency used for the payments:

USD - U.S. Dollar v

g' Currency to uss, update primary currency in General Ssttings page.
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5.1.4 Local Paypal Site Use

This is where you will choose which Paypal site you will use. There are a number of options
available, so make sure to choose the right one.

PayPal local site to use:
United Statez  »

g Paypal locale to use.

5.1.5 Default Post Purchase Price

Enter the default price of your posts. This is used for the Pay per Post transactions. It will be
the standard price for all of the posts, when purchased separately Make sure to only enter
numbers, do NOT include a $ dollar sign.

Default Post Purchase Price:

4

@' Post purchase price. Only available in modules which supports buypost,

5.1.6 Callback Information

5.1.6.1 Callback Thank You

This is where you will enter your callback thank you title as well as the thank you message.
This is what your customers will see once the transaction is completed.

Callback success title:

Thank You

@ Payment success page title.

Callback success message:

e

B I UESE==EE == FontSize.. Font Familv. FontFormat ~ = T epes | X x5 0T

Thank you for your payment. You will be receiving an email shortly to confirm the transaction.
Use the menu to the right or click one of the links below to continue.
Go to:

Homepage
Your Profile
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5.1.6.2 Callback Failed

This is where you will enter the callback failed title as well as the message. If the transaction
fails, this is what your customers will see.
Callback failed title:

There was a problem

g Payment failed page title.

Callback failed message:
= :=| FontSize... Font Farmilv. FontFormat ~ = = [# |8 ep €p @ |of X, x* 5 48 = [0

B I UESE
There was a problem with this transaction. You will be receiving an email shortly to confirm the problem
Use the menu to the right or click one of the links below to continue.

Go to:

Homepage

Your Profile

@ Payment failed page message.

5.1.7 Paypal Logo/Button and Description

Make sure to upload a picture for the Paypal Button or Logo from your computer, as well as
enter a description (If you want to) to let people know what Paypal is, in case they have not
used it before. The description you enter will be displayed with the logo at the subscription

payment selection screen.
Button/Logo:

I Browse...

g Buttonflogo image.

Description:
B I UE==EZE =:= FontSize.. Font Family. FontFormat - E =M e P[F X ¥ S E =@
PayPal is an e-money service allowing payments and money transfers to be made through the Internet.

PayPal operates with credit cards, debit cards, bank accounts and PayPal balance to make safe purchases
online, without disclosing your credit card number or financial information.

g Description shown on payment page.

5.1.8 Live Switch
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Live Switch is the option that determines whether your Paypal payments are live or still in the
Test Mode. With the test mode, you will be able to test out all of your payment options
without actually recording a transaction. Once you are done testing, make sure to change this
option from “Test Mode (Sandbox)” to “Live Site”. If you do not do this, no transactions will
be processed.

Test/Live Switch:

TEST A

g Switch between TEST/LIVE mode to test your payments. Not all modules supports this feature.

5.1.9 Custom Thank You URL

If you don’t want to use Magic Members’ Thank You page, you can always create your own.
Simply create a new page and use [transactions| shortcode to display the title and the
message.

Then access to Custom Thankyou URL setting field and type your page’s link.

Custom Thankyou URL:
hitp:/fwordpress.magicmembers.comitransactions?module=mgm_paypal&method=payment_processed
g Customn Thankyou URL for redirecting user fo payment successfailed page. This URL is meant o be updated inside your sile, you can

create & Wordpress post/page and paste the page url here.

Taqg:
[transactions] - Shows Transaction Details

NOTE: Remember to click the UPDATE button in order to ensure that the changes that you
make are saved!!!

5.1.10 IPN Setting (In-site Unsubscribe Settings) For Your PayPal
Account

After you log in to your PayPal account, follow these instructions to set up your listener:

1. Click Profile on the My Account tab.

2. Click Instant Payment Notification Preferences in the Selling Preferences column.

3. Click Choose IPN Settings to specify your listener’s URL and activate the listener.

4. Specify the URL for your listener in the Notification URL field (the one in Magic
Members).

5. Click Receive IPN messages (Enabled) to enable your listener.

6. Click Save.
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IPN/MNotify URL:

http://demo.magicmembers.com/subscribe?module=mgm_paypal&method=payment_notify

o' Notify URL for capturing silent post data sent from PayPal. READONLY, only for information. Please setup this URL in
your Paypal Account IPN settings in order to use unsubscribe featurs,

5.2 Payment Options ===> CCBill

1. You need to login your CCbill account at; https://admin.ccbill.com/

Powering =
of eCommerce

Signinas:  Clant Bt Account: 341643 Username: Password:

24” Client Support Forgot your ID/Password?

Support when and how you need it. CCBIll staff is ready to assist anytime Original Affiliate System

thraugh online live chat, e-mail, or phone:

OB ABliste Admia Sysicm

= Live Chat. how may we help you?
-+ E-mail: clientsupport@cchbill.com
= Call Us Toll free; 1-800-510-2859

CCBEill's online support center, knowledge base and integration center are

also available for added convenience. Want to use the

Old Client Admin?

Knowledge Base Client Support Center Integration Center
== View help files, == Quickly locate == Optimize your Cegill.com’

aticles and infarmative manuals business model using

release notes and guides CCBill's features

L Learn ore

24/7 Consumer Support Want to Sign-Up? 24/7 Affiliate Support
E-mail: support@ccbill.com Start Processing Today Email: clientsupport@cchill.com
Call Us: 1.888.596-9279 H www.cchill.com i CallUs: 1-800-510-2859

2. You are on CCBill Dashboard
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your mouse on "Account Info”
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o o oy ?‘"’ " 941643 |DOO1 - sanch Y. Quickdnd
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Education & Marketing

| Main Rccount
i Account Admin
Transaction Test Settings

E3 Account Setup

0 Data Link Discounts

Data Link Services Suite Cancel Discount

Datstink Report Layalty Discount

| Permissions Form Admin

User Ademin Global Farms

Group Admin {new) Farm Papups

L= | Wiew, modify, and custemize the existing subaccounts, Create pricing options
s} | | change i forms and mailers, and setup dialers. i [teRepase i

prasaps e Sub Accoume

@5 Link Client/Aff 105

(£ Custom Emails

Click “Account Admin”
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4. Select your “Subaccount” to edit it.
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Powering To lIse The Old Admin
B] LL | theFuture Select
.com. ' of eCommerce IIse Classic’
magicvembers Magic Members Client Account
Last Sign In:

Dacarber 2710, 2010 1003 e 1A 5

Home  Accountinfo  Report 5 Legacy Affiliste  Education & Marketing

Account Admin
Main Account Admin

Select Subsccount Accepted Billing Type
Create Subaccount

Yes  VisaMastercerd Discover JCB,On-ine Check EuroDebt Maestro
es  VisaMastercard Discover JCB Onine Check furoDeb Masstro
Pending  Visa Masiercord Discoves JCB.On-ine Check EuraDebd Maestro.

@ 1 '|@M1M1.Tuhnls e
5. Basic Settings. You need to fill all the necessary fields.
Powering To Use The Old Admin 8 Live cha
B{LL the Future Select Contact ©
.COM. | of eCommerce "Use Classic’ Report at
Magic Members Ehtﬂ;wl(
Quicklinks

cu
Last Sign In:
D = Please fill all the necessary fields

Home Accountinfo Reports WMS  Legacy Affiliste  Education & Marketing

Account Admin ‘Subaccount Basic Info
Modity Subaccount
. -Basie | Home URL hittp://sandbs
- Advanced Site Nanve I .
Traffic Manager the webske to onithe page. t Lcom to ster the Ske Name.
Form Admil
il sy Test Mode
Pricing Adrmin
Search Admin The TEST MOCE Feature has been phased-out of System'S and replaced by the new Transaction Test Setbings Feature found under the Account Mainkenance Tab, In the TOOLS area, Clck here for
instank sccess o Transaction Test Settngs,
Custom Emails
Usar Management Mmﬁ_‘ I

Reset All Forms
The email address where comespondence from CCOB wil be sent,
Account Change Forms

Vigw Subaccount Info Approval URL I N
Main Account Adrmin
OB wil brk the subscriber to this web location after a successful signup. This s typicaly the members area or 8 purchass raceipt. You must spacfy the Approval URL i the subaccount wil be processing

- transactions through CCEL
-
m The web location of the page used when a consumer's purchase is dedined.

Denial Redirect Time. s =

The time in seconds of the refresh time on the denial page,

Enable CAPTCHA
Opt Out URL 1
location of the page when they dick the Cancel Transaction button on the Confirmation page. Coly enter information in the Opk Out URL fisld if you are planning to use the
Confirmation page with Cancel Transaction ensbled on the page. For new subaccounts, the Opt Out URL feature is dissbled by defaukt. Please send an email to clientsupport@cchillcom for assistance
o activation.
Tour URL |

The: web location of the tour or preview area. This is the location to send consumers after they click 2 banmer or ad button, ideally the First page of the tour. Many times this URL is the same a5 the Home:
181

6. Advanced Settings. You need to fill all the necessary fields.
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Powering To Use The Old Admin : 8 Live Chat

[LL | theFuture Select ™ Contact CCBIl
.com. of eCommerce

e Claceic’ s Raport & bug
WVarsion: Pata
Magic Members f Client Account
b € o i wwi Please fill all the necessary fields ass.

Decambar 27th, 2010 10103

Account Admin Background Post Information
Madity Subaccoum

The permts Informatian, Cancel Information, Upgrade Security Setup Information, Customer Service Irformation, and Emad Vadation for a subaccount.
Background Past Irformetion ks used o st up URLS thet aptionally past customer data (mirws credit card and checking deteds), inchudie informstion sent to CCBM by wey of specific LRLs, when & transaction is
compisted,

Traffic Manager Appraval Past URL F
Fosm Adrmin
Pricing Adrmin The URL thet CCB wil send basic form data, via an HTTP Post, for new sign up sttempts that are spproved.
ol i Denial Post URL | |
Custom Emails
LSEr MANagement The URL that CCEill wil sand basic form data, vis an HTTP Post, For new sign up atbempts that are declned
ResetAll Forms
Account Change Forms Carcel Information
View Subaccount Info Cancel Information establishes the location and hyperink text for the customer Cancel LRL. When a customer stops a subscription on CCEIF Teoet Fior Cancel LRL given a5 a bk to the Cance| URL.
IF the Cancel URL bk i cicked, the Cancel URL ard  rat, they the Cancel LIRL seven seconds after cancelng service,
Main Account Admin
Cancel URL i 1
ADVANCRA | |- v cer s e ot s ey e ccts
W Teat for Cancel URL [ cancel and goto
The hyparbink ket b display For s customer that wil destribe the vsb leation specfied by the Canesl LRL,
Tracking Sanp
Tousa this feature, you must first obtain a tracking code from your Googls ™ Analytics account. Pasta the code in the Google Analytics box, and cick Update, You MUST use the Reset All Forms ink to
complete the process.
g up Google™ dnalvteson umwwwuw&factmmmtw To Soogle™, AL , make the change on the Main
instead of the aub-accourt (Medfy Main Aocount undsr ‘Adimin).

l Goagle Analytics [ [setting For allsub-accounks apples]

7. Your CCBill Form Name

Powering B uvochat |oSuiangy
the Future

Contact CCBill | Help
of eCommerce Report 8 Bug | Bug Fixes

varsion: fata Use Clagsic

€ Members Client Account
: v
941643 | 0001 - sandhx Quickdrks...

Reporis  WMS  Legacy Affilisle  Education & Marketing

e Main Account Info
Basic http:/fsandbax. Comnpary Name:  Magic Members
anced Sakuticns Company Address:
Approval URL bt /s andba,

mager

n. DeridURL: httpi/ffsandbox: o inf 5.00M
dmin -
i TorInL m] ame
drmin Biling Options:  Visa, Masterc.ard, Discover, 3B, Crnrine Check, -
mails 2
ament o Forms.
e User Management.

These are the forms you currently have st up.
Web Location: et Setup i

et System Type: NOKE % N
UM Type: NOKE Ilm CHECK
i info Username Type: USER DEFINED 20 oeEY
#hen Encryption: NOKE B DPEU
More..,
Regional Pricing - CCBill Recommended 9
Il::c.ﬂ CoBill Recommended Pricing, chck the Accept Regional Pricing button belbw, To visw the deme, click Prices: [ Saron 1505 For 355 dags =
Because the market fhuctuskes daly, we updste the CCBil Recommended Ratios on & regular basis. IF you cick the Accept Regions T | Recommended | Final Price Point | Additional
Regional Pricing button below you sre accepting todsy’s CCBHl Reccrmended Ratios. Ratio | x::::::
IF you wish to also. accept the iatics whenever |t is updated, please also select the I {usp)
DMln:rr:(mmWMM(mtRmmndPﬂnm.ﬂwmaﬁtmmmmbmsmlamm B ot s 7 e e
S vk 07808278 £a.12 057
Opt-in: [ 1 agres to allow CCBM to update my Rabos sutomatically, 037098110 78 o
usi Dizsbled theaugh man sccount
G s 1.0000000 00 #1014
11450475 3458 3034
1A274427 $481 0

Accept CCBM Riecormendsd Regonal Picng |
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8. Subscription Type ID

rering To Use The Old Admin [ e 8 Liceichat 21.508.0
Euture Select Veosr f""w Contact CCRIll | Help
ommerce "lep Classin' uickinks. . - Report a Bug | Bug Fixes
L C IC E: Version: Feta Use Classic
ibers Client Account

fqi " 941643 | DOOL - sanch ™ QR

Reports  WMS  Legacy Affiliste  Education & Marketing

Web Location:  Not Setup

Name Type Description
Sstom Vypes - NOKE: 108 CREDIT Pm Theme
108ek. CHECK Pastel Theme
I s i 1088 DPEL pastel Theme
Username Type: USER DEFINED 2760 DPEU Rasa
' e e S5dp DPEL Whks Ussmas 8 Paswond
More...
Regional Pricing - CCBIll Recommended ]
To accept COBHl Recommended Pricing, chck the Accept Regional Pricing button below, To view the dema, click Price: [34,06(U%0) for 365 days =
here. S st =2
Because the market fluctuates dally, we update the CCBil Recommended Ratios on a reqular basis. 1F you cdick the Accept Regions ¥ | Recommended | Final Price Point | Additional
Regional Prici =1 Ratios. Ratio E Realized
venu
£ you wish to also automaticaly accept the CCBMl Recommended Riatios whenever i is updated, please siso select the i (UsD)
Dpt-Tn checkbox prior to cicking Accept Regional Pricing, This indcates that we have you permicsion to spply the. i
updated ratios o your account, BE e 5oz 1 00 L)
Bhs ux. o.7808279 sz $0.67
ptin: I 1 agree to alow CEBill lo update my Ratios automaticaly. @ D 027648118 e $022
Status Disablect thrcasgh main accourt sehup e p PR pu
=l cansaa 11450475 3468 3034
[ hccept ccBaR RegonalPicig_| ol sl 14274427 3481 $0.32
| Decine Regional Fricing_|
Subscription Type ID
Pricing Options (-3
These are the pricing options you currently have set up.
Subscription Type Billing Type Service Type Discount
1294 £5,00 for 90 days (norvrecuring) credit cardcheck Standard Bilng
2597 $5.00 Fee 90 days then $5.00 récurring every 90 days eredt card/check ‘Standard Billing.
6156 $4.00 for 365 days (nan-recurring) credk card/check Standard Bilng
Maora.,

Activate CCBill payment gateway from
Magic Members --> Payment Options --> Payment Modules --> CCbill

Enter the followings;

CCBill Client Account No:

CCBill Client Sub Account:

CCBill Form Name:

And when you setup the subscriptions:

Magic Members --> Members --> Subscription Options --> Subscription Packages/Options

Create a package and set up;

CCBill Settings --> Subscription Type ID
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Epoch Settings

Product Code

CCBill Settings

Subscription Type 1D

Z2Checkout Settings

Product 1D

Subscription type ID is related with your subscriptions, you can find your Sub. Type ID's from
at:

CCBill Control Panel --> Account Admin --> Select Subaccount --> Pricing Options --> Sub.
Type ID

Please check the image number 8
When you create the "Subaccount Info" you are asked by CCBill;

Home URL:
Site Name:
Approval URL:
Denial URL:
Tour URL:
Billing Options:

You need to setup "Home URL", "Approval URL" and "Denial URL" properly,
Home URL: Your website address --> http://www.yourwebsite.com
You can modify your "Subaccount Info" through;

CCBill Admin --> Tool --> Select Your Sub Account --> Then Click the "Modify Subaccount”
link (on the left column)

Very Important Your Subaccount settings should be;

Basic Settings

Approval Post URL =>
http://www.yourdomain.com/payments/?module=mgm_ccbill&method=payment notify
Denial Post URL =>
http://www.yourdomain.com/payments/?module=mgm_ccbill&method=payment notify
Opt Out URL =>
http://www.yourdomain.com/transactions/?module=mgm_ccbill&method=payment cancel

Advanced Settings
Approval URL =>
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http://www.yourdomain.com/payments/?module=mgm_ ccbill&method=payment return&stat
us=success

Denial URL => BLANK

Cancel URL =>
http://www.yourdomain.com/transactions/?module=mgm_ccbill&method=payment cancel

5.3 Payment Options ===> Authorize.Net

= PayPal Standard = Authorize.Net = Waorldpay = Clickbank = Payment Modules

5.3.1 Main Settings

First of all, please make sure that you have enabled ARB in your Authorize.net account, and
copy your API login and Transaction Key.

5.3.1.1 Authorize.Net API Login ID

Authorize.Net APl Login Id:

o Authorize. Net Login id.

This is the API login ID, not your personal login ID!

5.3.1.2 Authorize.Net API Transaction Key

Authorize.Net APl Transaction Key:

& Authorize.Net Transaction Key,

5.3.1.3 Authorize.Net API Endpoints

If you're using Authorize.Net from a different payment processor, you can edit the endpoints
by clicking the checkbox.
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Authorize.Net APl Endpoints:
[[] Customize Authorize Met AP1 Endpoints?

g Authorize.Net custom api endpoints, nedded when Authorize Net used as gateway lo other payment processors.

5.3.1.4 Default Post Purchase Price

Enter the default price of your posts. This is used for the Pay per Post transactions. It will be
the standard price for all of the posts, when purchased separately Make sure to only enter

numbers, do NOT include a $ dollar sign.

Default Post Purchase Price:
4

@' Post purchase price. Only available in modules which supports buypost,

5.3.2 Callback Information

5.3.2.1 Callback Thank You

This is where you will enter your callback thank you title as well as the thank you message.
This is what your customers will see once the transaction is completed.

Callback success title:

Thank You

& Payment success page title.

Callback success message:

5|

W e X X0 5

B I UEZ=Z=E:=:=|FontSize. Font Familv. Font Format el
Thank you for your payment. You will be receiving an email shortly to confirm the transaction.
Use the menu to the right or click one of the links below to continue.

Go to:

Homepage
Your Profile

5.3.2.2 Callback Failed

This is where you will enter the callback failed title as well as the message. If the transaction
fails, this is what your customers will see.
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Callback failed title:

There was a problem

g Payment failed page title.

Callback failed message:
B I UEZ=Z=E:’=:= FontSize.. Font Familv. FontFormat | = E @ | H ep e @ | of X: 2 & F =[O

There was a problem with this transaction. You will be receiving an email shortly to confirm the problem.
Use the menu to the right or click one of the links below to continue.

Go to:

Homepage

Your Profile

@ Payment failed page message.

5.3.3 Authorize.Net Logo/Button and Description

Make sure to upload a picture for the Authorize.Net Button or Logo from your computer, as
well as enter a description (If you want to) to let people know what Authorize.Net is, in case
they have not used it before. The description you enter will be displayed with the logo at the
subscription payment selection screen.

ButtoniLogo:

Sy

Authorize Net

Payment Pracessing

g Buttondogo image.

Description:

B I UZ=Z=Z=Z:=:=|FontSize.. Font Family. FontFormat v EE B M e W% ¥ S B=m

Authorize.Met. ARB and AIM integration for Recurring payments and Single Purchase.

5.3.4 Live Switch

Live Switch is the option that determines whether your Authoirze.Net payments are live or
still in the Test Mode. With the test mode, you will be able to test out all of your payment
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options without actually recording a transaction. Once you are done testing, make sure to
change this option from “Test Mode (Sandbox)” to “Live Site”. If you do not do this, no

transactions will be processed.

Test/Live Switch:
TEST W

g Switch between TEST/LIVE mode to test your payments. Not all modules supports this feature.

5.3.5 Custom Thank You URL

If you don’t want to use Magic Members’ Thank You page, you can always create your own.
Simply create a new page and use [transactions] shortcode to display the title and the

message.
Then access to Custom Thankyou URL setting field and type your page’s link.

Custom Thankyou URL:

hitp:ifwordpress.magicmembers.comitransactions?module=magm_authorizenet&method=payment_processed

o Custom Thankyouw URL for redirecting user to payment successfailed page. This URL is mesant to be updated inside your site, you can
create a Wordpress post/page and paste the page vurl here.

Tag:
[ftransactions] : Shows Transaction Details

NOTE: Remember to click the UPDATE button in order to ensure that the changes that you
make are saved!!!

5.3.6 IPN Setting For Authorize.Net Account
Make sure you set the following link as the Silent Post Url in Authorize.net Merchant Panel.

IPN/Notify URL:

hitp:#iwordpress.magicmembers.comipayments ?module=mgm_authorizenet&method=payment_notify

& MNotify URL for capturing silent post data sent from Authorize.net. Set this url 2z the Silent Post Url in Authorize.net Merchant Pansl.
READONLY, only for information.

5.4 Payment Options ===> AlertPay
On AlertPay's Site:

Alertpay --> Business Tools --> I[PN Setup
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IPN Status: Enabled

Allow Encrypted Payment Details (EPD): Disabled

Alert URL:
http://www.yourdomain.com/payments/?module=mgm_alertpay&method=payment_notify
IPN Security Code: Generate and copy it

Enable IPN Version 2: Disabled

Test Mode: Disabled (Enabled, if you want to test it)

Alertpay --> Business Tools --> API Settings

API Status: Enabled

API Password: Generate and copy it

Test Mode: Disabled (Enabled, if you want to test it)
IP Address: Disabled

On Magic Members:

Access to Magic Members --> Payment Settings --> Alertpay

Alertpay Merchant Email: Your Alertpay e-mail

Alertpay IPN Security Code: Enter the IPN security code that you generate
Alertpay API Password: Enter the API password you created

Test/Live Switch: LIVE (Test, if you want to test it)

Also enable AlertPay for the subscription packs:

Magic Members --> Members --> Subscription Options

5.5 Payment Options ===> WorldPay

In WorldPay's account settings:

Payment Response Url in WorldPay = This should be same as the one in Magic Members -->
Payment Settings --> WorldPay --> Payment Response URL

Payment Response Enabled in WorldPay = enabled

You also need to have FuturePay (recurring billing) agreement with WorldPay.

In Magic Members' Settings:

You should set:
WorldPay Installation ID:
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WorldPay MD5 Signature:

5.6 Payment Options ===> 2Checkout

2Checkout:

Step 1: 2Checkout.com --> Notification ->Settings -> Global Settings --> Global URL -->
Enter Your IPN URL --> Apply

Step 2: 2Checkout.com --> Account -> Site Management -> Direct Return --> Immediately
returned to my website

Step 3: 2Checkout.com --> Account -> Site Management -> Secret Word = [set a unique
value]

Step 4: 2Checkout.com --> Products --> Edit Products --> Success/Approved URL: set this in
2checkout account PER PRODUCT

Step 5: 2Checkout.com --> Account --> Create Username
--> Select API Access
--> Select API Updating

Step 6: Set the information to:
Magic Members --> Payment Settings --> 2Checkout -->2Checkout API Username:
Magic Members --> Payment Settings --> 2Checkout -->2Checkout API Password:

Change www.domain.com with your own domain.

IPN/Notify URL:
:http://www.domain.com/payments/?module=mgm_2checkout&method=payment notify
Success/Approved URL:
http://www.domain.com/payments/?module=mgm_2checkout&method=payment return
Failure/Pending
URL:http://www.domain.com/transactions/?module=mgm_2checkout&method=payment can
cel
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Re-gilling : 1 ﬂ

Role ! Subseriber =l

Default : Tes ﬂ

Description : Gold Member - Access to all The Reinvention Workshop
videos and materials,

Hide Private Content : es j

Prior to Join

Display Settings

Active Coves x|
Sort Order : 1

Trial Settings

Use Trial 5 No ;I

2Checkout Settings

Product 12 = You need 1o write youwr 2C0 product ID
Module Settings
Use Module : [T 2Checkout m m m m m

Delete Package =

Add New Package =

5.7 Payment Options ===> iDeal

Please access to:
Magic Members --> Payment Options and activate iDeal gateway

Then, access to its setting page and fill:
Your Merchant ID

Your Merchant SUB ID

Your Secret Key

Then, you can access to Magic Members --> Members --> Subscription Options to create your
subscription packs.

When you create/edit your packs, make sure you enable iDeal Gateway by selecting the box
in Use Modules.

5.8 Payment Options ===> Ogone
Ogone configuration is as below:

Direct HTTP server-to-server request
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Timing of the request(radio button) select)

1.No request.

2.Always deferred (not immediately after the payment).

[SELECTED]3.Always online (immediately after the payment to allow customization of the
response seen by the customer).

4.0Online but switch to a deferred request in intervals when the online requests fail.

URL of the merchant's post-payment page:
If the payment's status is "accepted", "on hold" or "uncertain".
URL : http://www.domain.com/payments/?module=mgm_ogone&method=payment notify

If the payment's status is "cancelled by the client" or "too many rejections by the acquirer".
URL : http://www.domain.com/payments/?module=mgm_ogone&method=payment notify

Request method
POST [SELECTED]
GET

Apart from this , [ want to receive transaction feedback parameters on the redirection URLs
check box needs to be selected.

5.9 Payment Options ===> PayPal Website Payments Pro
For Magic Members and PayPal Pro Integration, you will need to follow the following steps:

. Go to the PayPal website and log in to your account.

. Click "Profile" at the top of the page.

. Click "API Access" in the Account Information column.

. Click "View API Certificate or Request API Credentials".

. Select "Request API signature."

. Click "Agree," and then click "Submit".

. Write down your API username, API password, and API Signature information. This is the
information you will need to enter into Magic Members in order to configure the integration
successfully.

8. Click "Done."

9. Access your site and go to Magic Members --> Payment Options --> PayPal Pro

Enter the required information.

NN DN R WN =

5.9 Payment Options ===> ClickBank
Here's how the ClickBank integration works:

After activating ClickBank gateway from:
Magic Members --> Payment Options --> Payment Modules

Enter your ClickBank user name and Secret Key.
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You can create your Secret Key via www.clickbank.com --> Account Settings --> My Site -->
Advanced Tools

You should also set us the Instant notification URL as
http://www.yoursite.com/payments?module=mgm_clickbank&method=payment notify

After you set the settings in ClickBank and Payment Gateway in Magic Members, create your
subscription.

You should enter your ClickBank product ID into the connected subscription ( into ClickBank
Product ID box)
Members --> Subscription Options --> enter your ClickBank product ID

5.9 Payment Options ===> Manual Payment

This gateway will allow your users to register without paying, but keep their account pending
until you approve them. This way they can pay cash or send a check to you. Once you receive
the payment, you can make their account active.

5.10 Payment Options ===> Payment Modules
= PayPal Standard = Authorize. Met = Worldpay = Clickbank = Payment Modules
This is the area where you may upload the icon or logo of whichever payment processors that

you choose to use. It is also where you will activate and deactivate them.

5.10.1 Activating/Deactivating Payment Modules
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Clickbank
&
CLICKBANK
No file chosen
U.pluad
ClickBank is a secure online retail outlet for

more than 10,000 digital product vendors
and 100,000 aclive affiliate marketers.

» Edit » Deactivate

Free

€ FREE

Choose File | No file chosen
Upload
Allow users to signup for a free account,
this Payment Gateway must be enabled for

Pay Per Post to work along with Paypal
Gateway.

» Edit » Deactivate

Trial
© TRIAL

No file chosen

Upload

Allow users to signup for a free trial account
which expires automatically after a number
of days. You can set the number of
daysimonths/years before 3 frial account
expires on the Subscription Settings page
Simply setthe Account Type to “Trial™ to use
this gateway.

» Edit » Deactivate

Worldpay
3% RBS WorldPay
visa| & D

No file chosen

Upload

Waorldpay is an electronic payment provider
that offers services for mail order and
internet retailers, as well as point of sale
transactions. All credit cards are accepted
and no accountis needed.

» Edit » Deactivate

Authorize.Net
Sy,

horize N
Clickp,
Choose File | No file chosen
= =

Authorize.Net. ARB and AIM integration for
Recurring payments and Single Purchase

» Edit » Deactivate

PayPal Standard
— PayPal’
B9 vsa 2

Mo file chosen

Upload

PayPal is an e-money sernvice allowing
payments and money transfers to be made
through the Internet PayPal operates with
credit cards, debit cards, bank accounts
and PayPal balance to make safe
purchases online, without disclosing your
credit card number or financial information.

» Edit » Deactivate

Simply click on the Activate or Deactivate button that corresponds with each payment
processor.

6. AutoResponders

™ Autoresponders

This section is all about the autoresponders and how to set them up so that your users can be
added to your autoresponder lists when they register.

6.1 AutoResponders ===> Aweber

You need to complete the following steps for Aweber Configuration;
Login to Aweber account:

Step 1: Create a form and get the details

Access to https://www.aweber.com/users/web_forms and click the Preview button to display
and view the source code. Then you can get the two required variables:

meta web_form id
listname
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Step 2: Set up on MGM

Login to Magic Members
2.1. Primary Settings:

Browse to Magic Members -> Auto Responders -> Aweber and Enable the module.
After that set the Web Form Id and Unit/List Name created on Step 1.

2.2. Field Mappings:

If you don't set anything here, integration will still work. It will map the e-mail address and
the first name, then send it to your list. But, if you want more fields to be sent to your Aweber
account, then please edit the fields that you want to map at Magic Members --> Content

Control --> Custom User Fields and select "Send to Autoresponder”.

You have to match the Name Tags in Aweber with the fields in Magic Members.

Fields | 1 || ||_| ] | EIMRGE m—DIVIDER m | rexr I
I T IN UsE Templates Show Templates | w
/J:‘ US Address Inputs = Verdana « | |12px ~| |B|| i || ‘
& Name IN USE
First Name:
Last Name:
3 I 1 g
/ Phone | |
Number Email:

Phone Number:

We respect vour email privacy

o Powered by Aweber Email Marketing

e Teswt W
M rRemove Text Whe SEaa

7 R e Remove Save

Let's say you added Phone Number as an additional field in your Aweber Form, you'll write
"custom Phone Number" in Field Mappings --> Aweber Field , then select the Phone field
from Field Mappings --> MagicMembers Field.
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<body><form method="post" class="af-form—wrapper" action="http://www.zweber.com/scripts/addlead.pl” onsubmit="return false;">

<div style= i

<input type: meta_web_form id" value="1837731123" />

<input type: meta_split_id" valume: />

<input type: istname"” value="mgmtest" />

<input type redirect” value="http://www.awsber.com/thankyou-coi.htmim=text” id="redirect_ sceb31aB6£8129e6££522200£272584e" />

<input type:
<input type
<input type=

idden” name="meta_zdoracking” value="My Web_Form" />
idden” name="meta message” value:
idden” name='meta required” value="name (awf_first),name (awf_last),email" />

<input

"hidden" name="meta_toolcip” value: />

af-form-1837731123" class="af-form"><div id="af-header-1837731123" class="zf-header"><div class="bodyText"><p>&nbsp:</p></dive</div>
af-body-1837731123" class="af-body af-standards">

f-slement">

'previewlabel” for="awf_field-28225253-first">First Name:</label>

f-texthrap">

awf_field-28225253-firsc" type="text" class="text" name="name (awf_firsc)" value="" tabindex="500" />

<div class="af-clear"></div>
</div>

<div class=
<label clas:
<div class=

f-slement">

'previewlabel” for="awf_field-28225259-last">Last Name:</label>

f-texthrap">

awf_field-28225253-1asc" class="text" type="cext" name="name (awf_ last)" value="" tabindex="501" />

<div class="af-clear"></divs</div>
<div class="af-slement">
<label class="previewLabel" for="awf_field-28225260">Email: </label>

<div class="af-textWrap"><input class="text" id="awf field-28225260" type="text" name="email" value="" tabindex="502" />
</div><div class="af-clear"></div>
<fdiv>

<div class=
<label clas
<div class=
<div class
<input name:
<div class=

f-slement'>

previewlabel” for="awf_Geal4ed7818d4721d7656240£7228244">FPhone Number:</label>

f-textlrap"><input type="text” id="awf_Seal4e97819d47e1d7656e40f72a8244" class="text” name="custom Phone Number” value='' tabindex="503" /></div>
f-clear"></div></div><div class="af-slement burtonContainer">

submit" class="submit" type="submit" value="Submit" tabindex="504" />

af-clear"></div>

You can click the following link for a bigger picture:
http://www.magicmembers.com/files/aweber-form.PNG

2.3. Membership Mappings

If you want different membership levels to have different mailing lists, you can map them
here.

Enter the "listname" as described in Step 1 into Aweber List/Group and select the membership
level.

Step 3: Activate Autoresponder

Browse to Content Control -> Custom User Fields and check (tick) the "I would like to
receive updates" checkbox
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Enable/Disable Settings
Setting Value
Enable? No E

o Enable/Disable the Aweber module.

Primary Settings

Aweber Field Value

Web Form Id

Unit/List Name ( default )

Field Mappings

Aweber Field MagicMembers Field
email E-mail { default )
Full Name [=] =

Membership Mappings

Aweber List/Group MagicMembers Membership Type

Guest E G

Update Settings »

6.2 AutoResponders ===> MailChimp
You need to complete the following steps for MailChimp Configuration;
Login to mailchimp account:

Step 1: Create API Key

Browse to:
https://usl.admin.mailchimp.com/account/

select "API Keys & Info" (right column)
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https://us1.admin.mailchimp.com/account/api -> add api key (if not already done)

Step 2: Create list

Browse to : http://us1.admin.mailchimp.com/lists/
Create new list -> fill the form as per need
After list is create note the Unique List ID (can retrieve that form list -> settings )

http://us1l.admin.mailchimp.com/lists/settings?id=658325 [658325 is the list id, this is not
Unique Id, please keep in mind. Look at the bottom part of this setting page]

Step 3: Set up on MGM

Login to Magic Members
3.1. Primary Settings:

Browse to Magic Members -> Auto Responders -> and set the List ID and API Key created on
Step 1 &2

3.2. Field Mappings:

You have to enter FNAME in the field mappings section for the Mailchimp field and match it
with either First Name or Full Name. This is minimum requirement. But, if you want more
fields to be sent to your Mailchimp account, then please edit the fields that you want to map at
Magic Members --> Content Control --> Custom User Fields and select "Send to
Autoresponder".

You have to match the Field Tags in MailChimp with the fields in Magic Members.

build it design it translate it share it

VRV field settings

field type text
add  design header  use text field label
FirstName
Add Header Image Graphic
field tag
any width x any height FNAME
field size
rrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrr : medium [=]
Findicates required [] required field
Email Address - o
field visibility

* - -
@ visible ) hidden

help text
First Name

default merge tag value 7

+ X

Last Name
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You can click the following link for a bigger picture:
http://www.magicmembers.com/files/mailchimp.PNG

3.3. Membership Mappings

If you want different membership levels to have different mailing lists, you can map them
here.

Enter the "Unique List ID" as described in Step 2 into MailChimp List/Group and select the
membership level.

Step 4: Activate Autoresponder

Browse to Content Control -> Custom User Fields and check (tick) the "I would like to
receive updates" checkbox

6.3 AutoResponders ===> iContact

Here's the step by step instructions for iContact.

1.From a top tab, select My Contacts

. From the Add Contacts box, select Sign-up Forms

. Scroll down and press the blue button:Create New Signup Form

. Here, you can choose a style, or you can skip it by clicking NEXT

. Name your new form

. Choose a list to add your new contact to

. Select the fields you want in your form (at least first name; email is already selected)

. Select any custom fields you want for tracking

9. Decide whether you want to require confirmation

10. Choose a Sending Option: Choose which campaign you would like this email to pull its
sending options from.

11. SAVE

12. On the page displayed after you save, scroll down to the Manual Sign-up Form section.
The code you see inside that box is your HTML form.

13. Place your cursor in the box, and right click your mouse and select all, then right click
again and select copy.

14. Paste to notepad so that you can easily see the entire form

15. Scroll down to near the bottom of the form and look for code that looks like this:

0N LN B~ W

input type=hidden name="listid" value="123456"

input type=hidden name="specialid:146184" value="XLPB"
input type=hidden name=clientid value="123654"

input type=hidden name=formid value="12345"

input type=hidden name=reallistid value="1"

input type=hidden name=doubleopt value="1"
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The information in quotes AFTER value = is the parameters needed to complete the plugin
setup form.

NOTE: The information provided here is for example ONLY. The values displayed in your
form will be specific to your iContact account.

Complete the Setup
Now go back to the Plugin page in Magic Members --> Autorespoders --> iContact

Copy and paste the values into the appropriate parameter field.
Click on Save.

6.4 AutoResponders ===> Constant Contact

You need to enter API Key, Username, Password , Contact id list into the related section
below;

Magic Members --> Autoresponders --> Constant Contact
You will need to enter;
API Key;

You can access the API key at;
http://community.constantcontact.com/t5/Documentation/API-Keys/ba-p/25015

Username, Password

and Contact List id;

Example;

ContactList id="http://api.constantcontact.com/ws/customers/trainermike/lists/1"

Then enable "autoresponder" custom user field in:
Magic Members --> Content Control --> Custom User Fields

You can also hide that field by editing and selecting Input Type as "Hidden Field". This way

they won't need to check the box, because there won't be any box and they will be added to
your list automatically.

6.5 AutoResponders ===> GetResponse

You need to complete the following steps for GetResponse Configuration;

Step 1: Create a New Campaign
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This section walks you through creating a new campaign on GetResponse. If you already have
a campaign, you can skip this section.

[GetResponse] From the home page, click the “Campaigns” tab

[GetResponse] Click “Create New Campaign”

[GetResponse] Fill in “Name”. The Name has to be unique across all of GetResponse This
will be used when you set up the integration within Magic Members.

[GetResponse] Click the blue “Create new campaign”

Step 2: Creating API

You can get your Get Response API key by clicking on the “My Account” link at the top
(inside GetResponse panel), and then click on the “Use GetResponse API” icon on the page
shown.

Or click on this direct link to obtain it: http://www.getresponse.com/my_api_key.html

Step 3: Set up on MGM

Login to Magic Members

Browse to Misc. Settings -> Auto Responders -> select active auto responder Getresponse and
set the Campaign Name.

Step 4: Activate Autoresponder

Browse to Content Control -> Custom User Fields and check (tick) the "I would like to
receive updates" checkbox

7. Reports

1", Reports

7.1 Sales

This is the section that you'll view your sales.

7.1.1 Sales Reports
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L I

Sales Report.
Date Range: Start: [Z eng oswoaz012  [E
Membership Type: All [z] | Generate Report
@
Sales
Date Subscription Pay Per Post Total Sales Date Subscription Pay Per Post Total Order Count
29/02/2012 §100.00 §0.00 §100.00 29/02/2012 1 0 1
23/02/2012 $1.00 $0.00 $1.00 23/02/2012 1 0 1
30/01/2012 §1.00 50.00 §1.00 30/01/2012 1 0 1
14/01/2012 $40.99 50.00 $49.99 14/01/2012 1 V] 1
02/01/2012 $9.99 §0.00 $9.99 02/01/2012 1 0 1
101212011 $99.98 $0.00 $99.98 101212011 2 0 2
071272011 $1.00 50.00 §1.00 07121201 1 0 1
061212011 $100.00 $0.00 $100.00 06122011 1 0 k|
051212011 §1.00 $0.00 $1.00 051212011 1 0 1
Total : $363.96 $0.00 $363.96 10 0 10

[Download PDF ]

In this section you can filter and view your sales in details.
e Date Range = You can pick start and end date to filter your sales.
e Membership Type = You can pick a membership type to filter the sales.
e Download PDF = This will create a pdf file of the report for you to download.

7.1.2 Sales Reports

In this section you will view your sales report on charts. There are 2 different charts here. First
one is the sale amount and date and the other one is sale count and date chart.
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7.2 Earnings

Earning report includes your recurring billing earnings with the sales that you are making all
together.

7.3 Projection

This section displays your future earnings. The calculations are based on the recurring billing
sales you have.

8. Misc. Settings

£ Misc. Settings
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8.1 Miscellaneous Settings ===> Settings

= General = Post/Page(s) - Messages =Emails = Auto Responders = Rest API

8.1.1 Main Settings

The Main Settings are Fairly self-explanatory, however here is a quick overview of what is
available to be altered.

8.1.1.1 Administrator email address

The email address that you enter here will be where all of the notifications will be sent.

8.1.1.2 Redirect url after login

If you check the box and set an URL, all the users except the administrator will be redirected
to the URL that you set after they login.

8.1.1.3 Redirect url after logout

If you check the box and set an URL, all the users except the administrator will be redirected
to the URL that you set after they logout.

8.1.1.4 Redirect url for category access denied

If you check the box and set an URL, all the users that has no access to the categories will be
redirected to the URL that you set.

8.1.1.5 Enable redirection to post/page url after content purchase or
login

Disable/Enable post url redirection. This allows the users to be redirected to the post url if
coming from a post/page. If this is enabled, login redirection url setting will be overridden.

8.1.1.6 Hide custom fields on registration page

This setting should be set to Yes at all times. The option all together will be removed soon
since admin can disable and enable the fields he want from the Custom User Fields section.
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8.1.1.7 Turn off emails from payment gateways

This setting will disable/enable gateway emails. This allows you to turn off the emails to the
administrator in case an IPN occurs (if applies).

8.1.1.8 Turn off payment notification emails from modules

This setting will disable/enable payment notification emails. This allows you to turn off the
payment notification emails to users.

8.1.1.9 Enable multiple membership level purchase
This setting will disable/enable multiple membership level purchase. This allows the users to

purchase multiple membership levels. Once activated, members can access to their
Membership Details page and purchase additional membership levels.

8.1.1.10 Enable nested shortcode parsing

This setting will disable/enable nested shortcode parsing. This allows the users to use nested
shortcodes.

8.1.1.11 Enable guest content purchase

This setting will disable/enable guest content purchase. This allows the guest users to
purchase content without registration.

8.1.1.12 Enable auto login after register

This setting will disable/enable auto login after register. This will auto login the user and
redirect to profile page after registration is complete.

8.1.1.13 Enable logout link

This setting will disable/enable logout link in menu.

8.1.2 Download Settings

8.1.2.1 Download Manager Hook

The hook that the download manager looks for. Default is "download" which would form
[download#1] within a post. If you're using some different plugins that uses the same
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shortcode, you can change it from here to avoid conflict.

8.1.2.2 Download Slug

The slug that appears in download url. After editing, refresh rewrite cache by using permalink
settings page and hit save once. Default is "download"

8.1.2.3 External Resource for Downloads - Amazon S3

If you have Amazon S3 account and you want to store your files there instead of your site you
can still use our Download module. Instead of uploading a file, you'll use the Direct URL
section to paste your file's link.

f aws.amazon.com AWS | Products | Developers | Forums = Support | Account Welcome, Magic Members = Sign Out

Elastic Beanstalk | 53 EC2 vPC | Cl h | Elastic duce | CloudFront | CloudFormation RDS | FlastiCache |SNS | 1AM

& Create Bucket || Actions = & Upload | {4l Create Folder | Actions = & Refresh | @ Properties | {8 Transfers || @ Help
Name Size Last Modified
[ file2.txt 20 bytes Thu Sep 01 15:30:06 GMT+300 2011

il magicmembers - -

@ Properties (+]
Bucket: ./ magic_products Details Permissions Metadata

Name: [ file2.txt

Size: 20 bytes Link: %t‘tps:/.-’sS.amazunaws‘cum.’maglc_pruduclsfﬂleZ.txt)

Last Medified: Thu Sep 01 15:30:06 GMT+300 2011

Owner: Me [ use Reduced Redundancy Storage

ETag: 81af83175de6a93726934b926c392560

Save || Cancel

@© 2008 - 2011, Amazon Web Services LLC or its affiliates. All right reserved. Feedback Support Privacy Policy Terms of Use An amazon.com. company
But before that, you'll need to setup some settings.

First of all access to http://aws.amazon.com/security-credentials to get your Access Key ID
and Secret Access Key.
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Access Credentials

There are three types of access credentials used to authenticate your requests to AWS services: {(a) access keys, (b)
¥.509 certificates, and (c) key pairs. Each access credential type is explained below.

“» Access Keys | [# %.509 Certificates ® Key Pairs |

Use access keys to make secure REST or Query protocol requests to any AWS service APL, We create one for you
when your account is created — see your access key below.

Your Access Keys

Created Access Key ID Secret Access Key Status
June 29, 2011 ( ) Show Active (Make Inactive)
Create a new Access Key Secret Access Key

— [ . e

/&

For your protection, you should never share your secret a (
practice recommends frequent key rotation.

& Learn more about Access Keys

Then copy and paste them to Magic Members --> Misc. Settings --> General Settings -->
Download Settings

@

Download Settings

Download Manager Hook:

download

&' The hook that the downlosd manager looks for. Default is “download" which would form [downlosd#1] within a post

Download Slug:

download

o/ The slug that appears in download url. After editing, refresh rewrnite cache by using permailink settings page and hit save once. Default is “dowrload”

External Resource for Downloads:

Enable Amazon s3 for Digital Downloads.

AWS Key:

( )

g AWS Key from Amazon Console, See AWS Security Credentials

AWS Secret Key:

( - )

v AWS Secret Key from Amazon Console, See AW'S Security Credentials.

Now you are set. You can add your Amazon S3 files to Magic Members Download module.
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8.1.3 Email Configuration & Settings

8.1.3.1 Email From

This is the e-mail address that will show on the e-mails that the members will receive.

8.1.3.2 Email From Name

This is the name of the sender (you or your site’s name).

8.1.3.3 Email Content Type

This is the content type of emails, html or text.

8.1.3.4 Email Charset

This is the charset of emails.

8.1.4 Account Expiration Reminder Email Configuration & Settings

8.1.4.1 Days to Start

This is the setting of the days to start sending the email. i.e. 5 Days

8.1.4.2 Incremental

If you activate this setting, you can send more than 1 expiration e-mail reminder. You can
setup the days' range i.e. 5,3,1. With wrong value provided, default will be used.

8.1.5 Payment/Subscription Settings

8.1.5.1 Select the Currency which will be used for the payments

You can choose from this drop-down menu which currency your want to use. There are a
variety of different options to choose from.

8.1.5.2 Your Subscription Name

This is the name that will show up on the order form.
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8.1.5.1 Use SSL for Payments

Do you want to make your payment page secure with SSL gateway? You must install SSL
before continuing.

8.1.6 Custom URL Settings

These are the pages that Magic Members uses for registration, login and user contents.
Registration and Transactions pages have to be created in order to registration to work.

8.1.7 Affiliate Settings
You can become a Magic Members affiliate and enter your affiliate ID into the box and start

making money with the sales you send. If you enable this setting a link will be displayed on
your footer.

8.1.8 Date Settings
You can become a Magic Members affiliate and enter your affiliate ID into the box and start

making money with the sales you send. If you enable this setting a link will be displayed on
your footer.

8.1.8.1 Date Ranges

This is the setting for date lower and upper range in all calendar popup fields.

8.1.8.2 Date Format

This is the setting for site wide date formats. You'll need to use php date settings in his
section.

8.1.9 Image Settings

The settings in this section is about the profile image custom user field. You can set the
thumbnail and medium image sizes as well as the file size.

8.1.9 Captcha Settings

In order to get the credentials, you'll need to go to
https://www.google.com/recaptcha/admin/create
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Re CAPTG HA' demo.magicmembers.com

= HOME

Domain Name: demo.magicmembears.com

reCAPTCHA will only work on this domain and subdomains. If you have more
than one domain (or a staging server), you can creale a new st of keys.

=} WHAT I3 reCAPTCHA

=+ GET reCAPTCHA
= MY ACCOUNT
MY SITES

Public Key: BLCKMsY SAAAAACZIk4NN02JA3bgIZThAQKDTLDDS

Use this in the JavaScript code that is served to your users

=} EMAIL PROTECTION

= RESOURCES

Private Key: ALcKMsY SAAAAAARHTRYIad]HaGneD--cCCAas0UM

Use this when communiczating between your server and our server. B sure to
keep it a secret.

Delete these kevs

Resources: reCAPTCHA plugins and libraries
reCAPTCHA AP Documentation

Now what? SUBSCRIBE to imporiant reCAPTCHA service announcements.

Install reCAPTCHA on your site. This is done in two parts. First, vou need
to add some HTML that displays the reCAPTCHA widget. Second, you
need to configure your form to contact our servers to verify reCAPTCHA
solutions. Here are specific instructions for: PHF, WordPress, and
MediaWiki. For other environments, visit our resources page.

If you need help, post your questions in the reCAFTCHA forum.

Type your domain name and click Create Key. After you create the keys like in the picture
below, copy and paste them to Magic Members --> Misc. Settings --> General Settings -->

Captcha Settings

Captcha Settings

reCaptcha Public Key:

reCaptcha Private Key:

reCAPTCHA API Server Url:

reCAPTCHA API Secure Server
url:

reCAPTCHA Verify Server Url:

Q[

6LcKMSYSAAAAACZIKk4nh02]A3balz7hAgKb7LbDS

& reCAPTCHA Public Key. Generate your key at
https:/ /www.google.com/recaptcha/admin/create?dx il d
app=Magic+Members

bers.com&

6LCKMSYSAAAAAANHY kv3ad4jHaGneD--cCC88s0UM

& reCAPTCHA Private Key. Generate your key at
https:/ /www.google.com/recaptcha/admin/create?d i d i bers.com&
app=Magic+Members

http://www.google.com/recaptcha/api

& reCAPTCHA API Server Url,

https://www.google.com/recaptcha/api

g reCAPTCHA API Secure Server Url.

www.google.com

g reCAPTCHA Verify Server Url
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Then activate the Captcha custom field at:
Magic Members --> Content Control --> Custom User Fields

9. Miscellaneous Settings ===> Post/Page(s)

= General = PostiPage(s) =~ Messages = Emails = Auto Responders = Rest AP

This is the section that you can setup protections with couple of clicks.

1. Select the Account Type

This area will have a list of all of the account types that you have created. Choose one of
them to setup.

2. Select Posts

In this area, you will choose what posts will be added to the account type. This is especially
important if you are creating multiple membership tiers such as Bronze, Silver, and Gold.

3. Select Pages

In this area, you can attach specific pages to the account type.

4. Select Custom Post Types
In this area, you can attach specific custom post type posts to the account types.
5. Decide If You Will Add Private Tags

If click the checkbox, system will add [private][/private] tags around your content. So, all of
your content will be protected. If you use Partly content protection with word limit, do not
select that box.

Once all of your selections have been made, click on the “Setup Posts” button at the bottom.

10. Miscellaneous Settings ===> Messages

= General = PostiPage(s) = Messages = Emails = Auto Responders = Rest API

This is where you will customize all of your messages that are affiliated with your
membership website.
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All of these messages have similar working areas, that will look similar to the one below.

Font Family. FontFormat « | &= = 5 &

After pressing the register button you will be asked to make payment for your registration.

10.1 Main Messages

10.1.1 Subscription Introduction

This is where you will customize the text that appears before the subscription options. HTML

formatting is allowed.

10.1.2 Terms and Conditions

This is where your should enter your terms and conditions. It will appear on the registration
page and all users must agree with it in order to complete the registration process.

10.2 Post Messages
These messages are what will be displayed within your posts. HTML can be used inside all of

these messages. Several special tags can be included as well:

[[purchase_cost]] = Displays the cost and currency of a purchasable post.
[[register]] = Displays the register form.

[[login_register]] = Displays the login or register form.

[[login_register links]] = Displays the links for login and register.
[[login_link]] = Displays only the Login link.

[[register_link]] = Displays only the Register link.
[Imembership_types]] = Displays a list of membership levels that can see the post/page

[[duration]] = Displays the number of days the user will have access to the content for.

[[mame]] = Displays user name.
[[username]] = Displays user username.
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10.2.1 Private Text [before login]

The message you enter replaces the text inside the [private]...[/private] tags in your posts and
pages when the viewer is not logged in.

10.2.2 Private Text [after login, but no access for membership type]

The message you enter replaces the text inside the [private]...[/private] tags in your posts and
pages when the viewer is logged in but is not allowed to see the rest of the post.

10.2.3 Private Text [after login, purchasable post]

The message you enter replaces the text inside the [private]...[/private] tags for your
purchasable posts when the viewer is logged in and has not purchased the post yet.

10.2.4 Private Text [before login, purchasable post]
The message you enter replaces the text inside the [private]...[/private] tags for your

purchasable posts when the viewer is not logged in. If you want your guest users to purchase
the posts, please use [purchase_options] shortcode.

10.2.5 Guest Purchase Text [before login, guest post purchase form]

The message you enter will be displayed to the user before the buy message for the guest
purchase form.

10.3 Error Messages

This is the place that you can customize various error messages that may occur.

10.3.1 Inactive Account

This is the error message that will be displayed when the user is not subscribed or has an
inactive account for other reasons.

10.3.2 Subscription Expired

This is the error message that will be displayed when the user attempts to login, but their
subscription has already expired.
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10.3.3 Trial Expired

This is the error message that will be displayed when the user attempts to login, but their trial
account has expired.

10.3.4 Subscription Payment Pending

This is the error message that will be displayed when the user tries to access their account, but
the subscription payment is still pending.

10.3.5 Unknown Error in login

This is the error message that will be displayed when the user cannot login for an unexpected
reason. This error message should not be used, as long as the system is properly functioning.

10.4 Misc. Message Templates

A variety of templates are available and will be used at various times. These are the templates
that are already included. They can modified at any time. It is important to included some of
the shortcodes, however any additional HTML can be added.

10.4.1 Membership Pack Description Template

e  When the packs are shown to the user, they are placed in a certain format.

e This allows you to change it using any or all of the following shortcodes:
[account_type], [cost], [currency], [duration], [duration period].

e [f your membership packs are a recurring payment and you have limited the number
then you can use [num_cycles] below to indicate the number of payments.

e [f you would like to use a Paypal trial then indicate this in the string using [trial cost],
[trial duration], [trial duration period] [description].

e Encapsulate any trial specific parts of the string in [if trial on][/if trial on] and for
those that are not using a trial, its contents will be removed.

10.4.2 Purchasable Post Pack Template

When you use [payperpost_pack#num] within a post or page this template will be called and
populated. Use the following shortcodes and any html you like to create your design:
[pack name] [pack cost] [pack currency] [pack description] [pack posts].

10.5 Payment Messages

This messages are already exist in all the payment gateways. If you use more than one
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gateways and want to update all the messages at once, you can use this section.

10.6 Message Templates

Templates under this section are design related.

10.6.1 Private Text Template

Wrapper template for private text messages. You can change this the way you want. Just keep
the [message] shortcode in it.

10.6.2 Register Form Row Template

Template for register form field row.

10.6.3 Register Form Autoresponder Row Template

Template for register form autoresponder field row.

10.6.4 Profile Form Row Template

Template for user profile form field row.

11. Emails

= General + PostiPage(s) = Messages = Emails = Auto Responders = Rest AP

11.1 General Email Templates

In this section you can setup your "Subscription Expiration Email Reminder Template" and
your "Registration Email Template". Both of the templates accepts html coding.

11.2 Payment Email Templates

In this section you can setup the following e-mail templates:
e Payment Success Template
o Post Purchase Payment
o Subscription Payment
e Payment Failed Template
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Payment Active Template

Payment Pending Template
Payment Error Template

Payment Status Unknown Template
Subscription Cancelled Template

11.3 Retrieve Password Email Templates

In this section you can setup the following e-mail templates:
e Password Link Template
e Retrieve Password Template

12. Magic Members Shortcodes

There are various shortcodes that you can use in your posts and pages. Some of them to
protect the content and some of them to display additional datas.

[user_register]| : Use this tag to display the registration form inside your post/page.
[user_subscription] : This shortcode displays the user membership informations such as
"Access Duration", "Last Payment Date", "Expiry Date", "Membership Cost", "Membership
Type" just like in Wordpress Dashboard --> Profile --> Membership Details.

[user_contents by membership] : This shortcode displays the content list of which
members can access to just like in Wordpress Dashboard --> Profile --> Members Content.

[private][/private] : The content between these tags can be viewed only with membership
level(s) you selected on the sidebar.

[user_has_access#??][/user_has_access] : The content between these tags can be viewed
only if the user has access to specific post/page where ?? is the post_id.

[no_access][/mo_access] : You can use this shortcode to display message/audio/video to your
visitor who has no access to the content. Anything you put between these tags will be
displayed only to the users who don't have access. If users have access to the page, they won't
see the content between no_access tags.

[download#??] : This tag will show the download link that you add using our download
module. ?? is the download file ID. Don't forget to put this tag between private tags to protect.

[payperpost_pack#??] : This tag will display the Pay Per Post Pack purchase information
and button. ?? is the pack ID.

You can find all the other shortcodes in Docs folder when you extract your .zip file.
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13. Magic Members Widgets
Magic Members provides various widgets for you. All our widgets can be used multiple times.

e Magic Members Register

This is a registration form widget. You can include custom fields and payment options.
e Magic Members Login

This is a detailed login widget. It also includes some shortcodes for you to use.

e Magic Members Status
This widget will display your members' account details.

e Magic Members Text
You can add text or html in this widget. And you can select which membership type
can see it.

III. PROTECTING YOUR CONTENT

1. Content Protection Methods

i Wordpress Experts

Access + Download - Page + Custom User Fields

i . - Jw]
.j Magic Members Full Content Protection Settings
£ Members ;
Would you like to hide all of your content?

|
B Content Control | Content Protection @ FULL @ PARTLY & NONE

" ‘Word Limit for Public Access: 0

Pay Per Post
?
¢ Payment Settings Protect your contents
L B FULL = Protects contents aulomatically. All Contents will be protected and users have to login before viewing. [private] tags added manually will be
honored.

& Misc. Settings
PARTLY = Protects contents automatically. Fart of the content will be free and rest will be viewable after login. [private] tags added manually will be
} #* Tools henored.

NONE = No protection will be applied. Any settings in post{page setup and [private] tags added manually will be disregarded unless postipage is sef as
i= Support Docs Purchasable.

Purchasable Post will always require login irespective of Content Protection setfings.

Extended Content Protection:

Hide Content By Membership ) Yes @ No

Controls wheather posts/page are hidden by current user membership fype.

1.1 FULL Content Protection

When you enable Full Content Protection all of your pages/posts will be protected
automatically. Your visitors won't be able to see any of your posts/pages content. They can
still see your post's/page's titles, but the content won't be displayed.
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You'll need to edit the existing posts/pages and select a membership level from the right
sidebar to give access to the content.

And if you use [private][/private] tags in the post/page, Full Content Protection will be
deactivated for that post/page.

If you want some of you pages to be accessible for everyone. You will need to select all the

membership levels including Guest for that page.
@ Wordpress Experts Howdy, admin

s+ Edit Post  asunew

Screen Options Help

SEO Software Magic Members

Permalink: hitp:/wordpress. magicmembers com/seo-software/ [ Edit View Post Get Shortlink
P v SR - Select which membership types will have

access to read this post/page. Note: The
Upload/lnsert = A £ 3 Visual |HTML private parts of the post should be inside the
following tags: [private] your text [[private]

b i link = b-quote dal | ins img | ul | ol li code | more | lookup || close tags || fullscreen

[ Select all
Here's the latest version of the best SEQ Software:

[] Guest
[private] [ Trial

[] Free
[download#1] —

[¥] Silver
[/private] [ Gold

[¥] Platinum

[F] PPP

Pay Per Post: Edit
Word count: 11 Last edited by admin on October 12, 2010 at 1:57 pm

Post Delay (sequential posts): Edit

1.2 PARTLY Content Protection

1.2.1 If You Set the Word Limit Higher Than 0 (zero)

Partly and Full content protections are similar. The only difference is when you set a word
limit like 70, all of your pages/posts become accessible until 70 words and become protected
after 70 words.

You'll need to edit the existing posts/pages and select a membership level from the right
sidebar to give access to the content.

And if you use [private][/private] tags in the post/page, Full Content Protection will be
deactivated for that post/page just like Full content protection.

If you want some of you pages to be accessible for everyone. You will need to select all the
membership levels including Guest for that page.

1.2.2 If You Keep the Word Limit as 0 (zero)

When you set the content protection to Partly and keep the word limit as 0, you enable the
manual protection mode. None of your posts/pages will be protected automatically.

If you want to protect a page/post, you'll need to use [private][/private] tags around the
content you want to protect. You can use the private tags anywhere. You can protect all of the
content in the page or you can protect just a word. Then you'll select the membership level(s)
to access it.

1.3 NONE Content Protection

If you enable None, all of your content will be accessible to everyone. Usually non-profit
organizations use this setting.
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1.4 EXTENDED Content Protection

This settings is set to "No" as default. If you want to use Private Tag Redirection Settings,
you'll need to keep this as "No". So, here's what happens if it's Yes;

Protected posts/pages become hidden. Users with the incorrect membership level(s) or guests
users won't see the posts/pages on your site. This setting removes the protected pages/posts
from your site completely. Only logged in users with the correct membership levels can
display them.

2. Category Protection

Screen Options Help

s+ Edit Category

Name Module 1

The name is how if appears on your sife

Slug module-1

The “slug” is the URL-friendly version of the name. It is usually alf lowercase and contains only letters, numbers, and hyphens.

Parent None
Categories, unlike tags, can have a hierarchy. You might have a Jazz category, and under that have children categories for Bebop and Big Band. Totally
optional.

Description

The description is not prominent Oy default, however some themes may show it

'8 '
Category Access [ Guest

[ Trial

[[] Free

[F] silver

Gold

[F] Platinum

[F] PPP

(Leave all unchecked for public access to this category )
. J/

Update
When you edit your categories you will see a new section called Category Access. You can

select the membership level(s) you want to give access to the category you're editing. If you
want everyone to access it, leave all of them unchecked.

3. Content Protection with Shortcodes

These are the shortcodes that you can use when you write your posts/pages.

3.1 Private

Usage: [private] [/private]

Description: The content between these tags can be viewed only with membership level(s)
you selected on the right sidebar.

3.2 User Account is

Usage: [user_account is#gold] [/user_account_is]
Description: The content between these tags can be viewed only with Gold membership
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owners. You change the "gold" with any membership level you have. You can also use
multiple membership levels with this shortcode. Ex: [user account is#gold#silver/#platinum]
[/user account is]

3.3 Private or

Usage: [private or#123][/private or] : 123 = post_id

Description : Content inside private tags is protected. Only users with account types selected
on the sidebar or in the tag being able to access content. (User has to have the selected
membership level or he has to have access to a specific post).

3.4 Private and

Usage: [private_and#123][/private_and] : 123 = post_id

Description : Content inside private tags is protected. Only users with account types selected
on the sidebar and in the tag being able to access content (User has to have the selected
membership level and at the same time he has to have access to a specific post (possibly a
PPP, but doesn't matter)).

3.5 User has Access

Usage: [user_has access#123][/user_has access] : 123 = post _id

Description: The content between these tags can be viewed only if the user has access to
specific post/page .

4. Download Protection

4.1 Protecting Your Download Files

If you want to protect your downloadable files, you can use our Download module. Magic
Members will encrypt the links so no one could access to the actual file path.

In order to use the download module please access to:

Magic Members --> Content Control --> Download

Then, click Add New Download.
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= ACCEess = Download = Page = Custom User Fields

Edit Download
Title (required) Special Seo Software 1
Upload a file I Qi 2
File: 13053400.zip.
Direct Url:  http:/hwordpress. magicmembers. comiwp-content/uploadsimgmidownloads/ 13053400 zip 2
Protected Url: htip-/Awordpress magicmembers.com/download/?code=4cat1f191152d
Resirict Access? 3 III If checked. only users of the appropriate access level can access the file. User level is calculated by checking access to a certain post or posts.
Marketing Tricks August 2010 Issue -
Marketing Tricks July 2010 Issue
Marketing Tricks June 2010 Issue
Members Only
Membership Details i
Mixed Access Post
4 Froite
Protected content
Register E |
SEOQ Software
Summer Deal
Transactions
Wrong Membership Level =
Expire Date = 5
&' Available Tags
[download#1] - Download link
[download# 1#mage] : Image Download link
[download# T#button] | Button Download link
[downloadt T#size] - Download link with filesize
[download# 1#url] - Download url only
Save » 6 « Cancel

1. Add a title for your download file. This will display when you use your download
shortcode.

2. There are 2 ways to add a download file. First one is to select a file to upload. Second one
is to use the Direct URL section. You can write down a direct link for a file you previously
uploaded. Your files have to be uploaded to /wp-content/uploads/mgm/downloads/.

3. If you want to restrict access to the file you add, then check the box.

4. If you checked the Restricted Access box, then select a page/post to restrict the access to.
This way only the users who have access to the selected page/post can download the file.

5. Set an expiration date for the download file. If you don't want it to expire, just leave it
blank.

6. Save it.

Now that you protected your file, you can add it in your post/page and select a membership
level to access it.

Ex: [private] [download#1] [/private]

1 is the download file ID. You can check them at Magic Members --> Content Control -->
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Download

Here are all the available download tags:
[download#1] : Download link
[download#1#image] : Image Download link
[download#1#button] : Button Download link
[download#1#size] : Download link with filesize
[download#1#url] : Download url only

IV. FREQUENTLY ASKED QUESTIONS

1. How can I import my users from another platform?

a. First step is to create your profile/registration fields and enable them:
Magic Members --> Content Control --> Custom User Fields

Create/Edit Custom Field

Add Custom Field
Label :
Name :
@' default lowercase label value, spaces replaced by underscore.

Input Type : Text Field (Single Line) [+ ]
Display/Atiributes : :

[ Required!

[[] Readonly

[ Hide Label

[ Send to Autoresponder

[] Show On Register Page

[] Show On Profile Page

[[] Show On Payment Page

[] Show On Public Profile Page

@' DisplayUsage seltings for the fields.

Save =

b. Create a user manually, then edit the user and complete all the fields that you want to use.
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Name
Username
Rale:
First Mame
Last Mame
Mickname (required)
Display name publicly as
Contact Info
E-mail {required)
Website

About the user

Biographical Info

Mew Password

Birthdate

Update User

c. Export the user via:

Batman

Subscriber (=]

Bruce

Wayne

Batman

Batman

batman@superheroes.com

Usernames cannot be changed.

Share a little biographical information to fill out your profile. This may be shown publicly.

If you would like to change the password type a new one. Otherwise

leave this blank.

Type your new password again.

Strength indicator

Hint: The password should be at least seven
characters long. To make it stronger, use upper and

lower case letters, numbers and symbols like ! "7 8% ~ & ).

Magic Members --> Members --> Members --> Export User Data --> Export
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Export User Data

Membership Type: All |Z|
Membership Expires: Days |z|
Date Range: Start: = End =

[[] Exclude Expired Users

Export =

Now you have a sample file to use for your import. You don't need to use all the columns.
Delete the ID columns (not the user id).

Delete empty columns.

Delete duplicate columns.

Make sure you have user login, user email, membership_type, pack id fields in your XLS
file.

d. After preparing your .xls file, access to:
Magic Members --> Tools --> Data Migrate --> Import User Data

Import User Data

Please Select File: Browse..

@ Supported File Types: CSVWXLS
Minimum Fileds reguired: [user_login, user_email, membership_type, pack_id].
Custom field Names can &lz0 be included.

Maximum number of records that can be imported st once: 2000

Import Userss

2. How can I Create Membership Levels and Subscription Packs?

In order to create a membership level access to:
Magic Members --> Members --> Subscription Options --> Membership Types
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Platinum B [F] Delete and move this membership type's members to

—none-—
[[] Login Redirect URL:

[] Logout Redirect URL:

PPP [C] Delete and move this membership type's members to
E
—none--

[ Login Redirect URL:

[ Logout Redirect URL:

WIP New Membership Type. (250 Characters mai.)
http:/iwordpress.magicmembers.comiip-members/ Login Redirect
http:iwordpress.magicmembers.comi Logout Redirect

@' Please provide a new Membership Type and click on update. Please do not use any special characters in Membership Type name.

Update =

Enter your membership level's name right next to New Membership Type. You can also set

the Login and Logout redirection links for the membership level you created. Then click
Update.
After you create your membership level, it will display in the Subscription Packages list.

= Members = Subscription Options = CoUpons = Roles & Capabilities

Subscription Packages/Options

Subscription Packages

+ Silver

' Gold

+ Platinum
+ PPP

v VIP

Add New Package »

Update Packages =
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Then you can add the subscription packs under your new membership level. You can create
multiple payment /duration option for your membership levels.
When you click Add New Package, you will see the following settings:

T VIP

Package #9

Basic Settings

Membership Type
Duration

Cost

Billing

Role

Default

Description

Hide Private
Content Prior to
Join

When
expired/cancelled,
move members to

Display Settings

Active on
Hidden?

Sort Order

Irial Settings

Use Trial

Payment Settings

Allow Renewal

Use Modules

VIP

0.00

OngoingE

Subscriber |Z|
No  [=]

Vip

No

' If selected Yes, members can access only the content which are published after their registration date.

None [=]

& If selected, member's will be assigned with the selected pack when expired/cancelled.

Register page Upgrade page Extend page

[F] Hide on General Registration

9

No  [=]

Yes [x]

Paypal Standard [[] Authorize.Net [[] Moneybookers [[] PagSeguro

Package Register URLs/Tag

Custom URL

Wordpress URL

Tag

Delete Package »

Add New Package »

http://fwordpress.magicmembers.com/register?package=dmlwIlzk
http://wordpress.magicmembers.com/wp-login.php?action=register&package=dmlwIzk

[user_reqgister package=vip#9]
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Here's an example:

Basic Settings:

- Membership Type: Member/Gold/ ...
- Duration: 1 Month

- Cost: 14.95

- Billing: Ongoing

- Role: Subscriber

- Default: Yes/No

- Hide private content prior to join: No
Display Settings:

- Active: Yes

- Sort Order: 1

Trial Settings:

- Use trial: Yes

- Trial Duration: 7 Days

- Trial Cost: 0.99

- Trial Occurrences: 1

Payment Settings:

- Allow Renewal: No

- Use Modules: checked: PayPal Standard
This subscription pack is for 7 Days trial for $0.99, then $14.99/month ongoing billing.

3. Where is My Registration Page and How does the Registration
Process Work?

Your default registration page is set to http://www.yourdomain.com/register

Logged in users can't display the registration page, so please logout or open a different
browser to see it.

Here are the registration steps:

1. User access to the registration page

2. User fills the form and click register

3. User becomes a member right away. He receives user/pass via e-mail, but his account is set
to Inactive. He can't access the site

4. User redirects to the payment gateway's site

5. User makes the payment

6. User clicks to the "get back to the site" link on the gateway's site

7. a. If payment is successful, user displays the Thank You page (completely customizable)
b. If payment is unsuccessful, user displays the Error page (completely customizable)

8. User's e-mail and other data (if set) are sent to the autoresponder list (optional)

9. User automatically logs in the site (optional)

10. User access to the protected content

4. How do I Eliminate the Payment Gateways Selection Page?

If you only use one payment gateway, you can activate "Payment Gateways" custom user
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fields at Magic Members --> Content Control --> Custom User Fields .

Phone phone text Show
Username username text Show
E-mail email text Show

Photo photo image Show

Website url text Show
Display Name display_name select Show
Description description textarea Show
Nickname nickname text Show

(I:\D O O O D O I

Payment Gateways pa}'ment_ga@ label Show

If you enable it, your users will be redirected to the payment screen after they click the

Register button. They won't see the Payment Gateway selection page.

Edit

Edit

Edit

Edit

Edit

Edit

Edit

Edit

Edit

System

System

System

System

System

System

System

System

System

If you have more than one active payment gateway, you can still activate the field. This time

the gateway selection options will be added to your registration form.

5.1 have CSS and some PHP knowledge. How Can I Modify the
Registration/Profile Form?

For the design changes of the registration/profile rows please access to:

Magic Members --> Misc. Settings --> Messages --> Register Form Row Template:
Magic Members --> Misc. Settings --> Messages --> Profile Form Row Template:
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Register Form Row Template:

=div clags="Tuser_field_wrapper™
=label=[user_field_label}=/llabel=
=p={user_field_element]=/p=
=div=

Register Form Autoresponder Row Template:

=div class="Tuser_field_wrapper=
=p={user_field_element] <label=[user_field_label}<label==/p=
=fdiv=

& Template for register form autoresponder field row

Profile Form Row Template:

=div class="user_field_wrapper]™=
<label=[user_field_labell<Nabel=
=p=[user_field_element}=/p=
=idiv=

o Template for user profile form fisld row.

Also, every registration/profile field that you have in the registration/profile form have their
own classes. Since they're created dynamically, you can check them and see when you view
the source of the registration/profile page.

For the pages' design: There are two templates for each customizable output,

1. root template - can be overridden by a same name file in theme folder

i.e : register_page.php - generates registration page with title and registration form

2. design template - cannot be overridden as of now but meant only for default installation
with default output.

i.e: register_page return.php

You can override the output in multiple ways
1. Use short code for registration, which will generate the form only
[user register]

2. Create a template file and call the mgm callbacks with own layout,
using

mgm_get user register page_title() and

mgm_get user register page html()

3. Best: Create a file named register _page.php inside your theme folder and design it the way
you need, add mgm callbacks (in #2 ) and get the output you want.

Each file in core/html folder can be overridden by same procedure, return.php file are for
internal use only but you can copy them to your theme folder and customize.
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6. 1 Have a Cache Plugin. Will Magic Members work properly?

If you have W3 Total Cache plugin. You need to add some pages to the "Never cache the
following pages:" list on Page Cache, Minify and Database Cache setting pages. These are;

register
transactions
payments
login
download
lostpassword
subscribe

If you changed any of the links above for your site, then you'll need to add them also.
If you have other cache plugin, just add the pages listed above to their do-not-cache lists.

7. How can I Create Pay Per Post or Pay Per Post Packs?

For PPP, you create a post and then use the [private][/private] tags in it.

And select the membership level to access it. If you don't want anyone to access it, just create
a new membership level and select that one.

Then click the "Edit" button near "Pay Per Post".

Select "Yes" where it says "If the user doesn't have access, is this post/page available to buy?"
Set your price and publish it.

When your members access to that page, they will see a purchase button.

8. My Visitors Make the Payment, but Their Account Show Inactive.
What Went Wrong?

There might be couple of reasons for this issue.

1. You're using the default permalink setting in Wordpress. If this is the case, Magic Members
won't work. If that's the case, please access to Wordpress Dashboard --> Settings -->
Permalinks
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Appearance
. Common Settings
& Plugins

% Users () Default http://wordpress.magicmembers.com/2p=123
Ti Tools -
() Day and name http://wordpress.magicmembers.com/2e12/@1/e4/sample-post/
& Settings
) Month and name http://wordpress.magicmembers.com/2812/81/sample-post/
General
Writing ) Numeric http://wordpress.magicmembers. com/archives/123
Reading
Discussion @ Post name http://wordpress.magicmembers.com/sample-post/
Media .
() Custom Structure
Privacy ~ /¥postname®/
Permalinks Optional

Change your setting to anything other than Default. After that put the correct links at:
Magic Members --> Misc. Settings --> General Settings --> Payment/Subscription Settings

Payment/Subscription Settings

Select the Currency which will be used for the payments:

USD - U.S. Dollar [=]

g All Psyment transaction currency

Your Subscription Name:
Wordpress Experts Subscription

& The name of the membership to display on the order form.
Use [blogname], [membership] tags to set blogname and membership respectively.

Register URL:
http:/fwordpress.magicmembers.comiregister
g Custorn Register URL for regsiter and related actions. This URL is meant to be updated inside your site, you can create @ Wordpress post/page and

paste the page url here.

Tag:
[user_register] - Shows Register Form

Profile URL:
http:iwordpress.magicmembers.comiprofile
& Custon Profile URL for profile and related actions. This URL is meant to be updated inside your site, you can create & Wordpress postipage and paste

the page url here.

Tag:
[user_profile] : Shows Profils

Transactions URL:
http:/wordpress.magicmembers.comiftransactions
& Transactions URL for redirecting user to payment successfailed page. This URL is meant to be updated inside your site, you ean create 2 Wordpress
postipage and paste the page url hers.

Tag:
[transactions] : Shows Transaction Details
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After that, deactivate and reactivate your payment gateways at:
Magic Members --> Payment Settings --> Payment Modules

2. Your Payment/Subscription links are incorrect.

If that's the case, please correct them at:

Magic Members --> Misc. Settings --> General Settings --> Payment/Subscription Settings
After that, deactivate and reactivate your payment gateways at:

Magic Members --> Payment Settings --> Payment Modules

3. You are using a Cache plugin. If this is the case. Please follow the steps at "I Have a Cache
Plugin. Will Magic Members work properly?".

4. You disabled Subscription Options custom user field. If that's the case, please re-enable it,
because it's required to assign the users to their subscription pack.

9. How Can I Setup Recaptcha?

You'll need to follow couple of steps to activate Recapthca on your site.
Go to https://www.google.com/recaptcha/admin/create

Re Cﬂ‘PTC HA demo.magicmembers.com

Domain Name: demo.magicmemhbers.com

reCAPTCHA will only work on this domain and subdomains. If you have more

HOME tham one domain (or a staging server), you can create a new set of keys.
WHAT IS reCAPTCHA
GET reCAPTCHA
e Public Key: BLcKMsYSAAAAACZIkdnh(2JA3bglz7hAgKb7LDDS
= MY ACCOUNT o ) .

MY SITES Use this in the JavaScript code that is served fo your users
EMAIL PROTECTION
RESOURCES Private Key: BLCKMsY SAAAAAANHTKY3a4]HaGneD--cCCa8s0UM

Use this when communicating between your server and our server. Be sure to
keep it a secret.

Delete these keys

Resources: reCAPTCHA plugins and libraries
reCAPTCHA APl Documentation

Now what? SUBSCRIBE to important reCAPTCHA service announcements.

Install reCAPTCHA on your site. This is done in two parts. First, you need
to add some HTML that displays the reCAPTCHA widget. Second, you
need to configure your form to contact our servers to verify reCAPTCHA
solutions. Here are specific instructions for: PHP, WordPress, and
MediaWiki. For other environments, visit our resources page.

If you need help, post your guestions in the reCAPTCHA forum.

Type your domain name and click Create Key. After you create the keys like in the picture
above, copy and paste them to Magic Members --> Misc. Settings --> General Settings -->
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Captcha Settings

Captcha Settings

reCaptcha Public Key: BLCKMSYSAAAAACZIk4nh02]A3bglz7hAqKb7LBDS

@' reCAPTCHA Public Key. Generate your key at

@u

https://www.google.comfrecaptcha/admin/create?domains=demo.magicmembers.com&

app=Magic+Members

reCaptcha Private Key: BLCKMSYSAAAAAARH7kv3adiHaGneD--cCCB8SOUM

g/ reCAPTCHA Private Key. Generate your key at

htitps:/ fwww.google.com/recaptcha/admin/create?domains=demo.magicmembers.com&

app=Magic+Members

reCAPTCHA API Server Url: http://www.google.com/recaptcha/api

g’ reCAPTCHA API Server Url,

reCAPTCHA API Secure Server

: https://www.google.com/recaptcha/api
url:

o reCAPTCHA APT Secure Server Url,

reCAPTCHA Verify Server Url: www.google.com

@/ reCAPTCHA Verify Server Url

Then activate the Captcha custom field at:
Magic Members --> Content Control --> Custom User Fields

Custom Registration Fields

Active? Label Name/lD Type Others

Subscription Introduction subzcription_introd uction htrml Show

Subscription Options subscription_options label Show

I would like to receive autoresponder checkbox Show
updates.

Captcha captcha ) captcha Show
| Terms and Conditions terms_conditions html Show
(] Birthdatsa birthdate text Show
o Country country =elect Show
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10. I Want My Content To Be Delivered with Drip Feed. How Can I Set It
Up?

You can easily setup your posts to be delivered by delay. You will have various membership
levels, let's say Free, Silver and Gold.

First of all you'll need to protect your content with [private][/private] tags. After that you'll
need to select a (or more) membership level to access it.

Delayed Content Magic Members

Permalink: hitp:liwordpress. magicmembers. comidelayed/ [ Edit Select which membership types wil have
access to read this post/page. Note: The

private parts of the post should be inside the

Upload/insert 5k ; HTMI
Hime L following tags: [private] your text [/private]
B I = |-« == &R ¥-EE W hinian
Paragraph ~ U = A ~ e ol =(=n (7]
[ Guest
This text is viewable by everyone. ] Trial
[private] [¥] Free
rivate
: Silver
This text is viewable by registered members who have access. ¥ Gold
[ Platinum
[fprivate] ] PPP
EwviP

Pay Per Post: Edit

Post Delay (sequential posts): Edit
Path: p
Ward count: 18 Draft saved at 3:26:58 pm. Publish

You will also see a section on the right which belongs to Magic Members.
When you click Post Delay section, a menu will appear like:

Post Delay (sequential posts): Close

How long should the user have been a
member to see this content?

Guest i} Day(s)
Trial ] Day(s}
Free 0 Day(s)
Silver 0 Day(s)
Gold 0 Day(s)
Platinum 0 Day(s)
PPP 0 Day(s)
VIP 0 Day(s)
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You can set them as:

Free 10 Day(s)

Silver 5 Day(s)

Gold 0 Day(s)

This way, the content will be available for Gold users right away. For Silver users it will be
available 5 days after their registration date and for Free members the content will be
available 10 days after their registration date.

11. When Visitor Try To Access My Pages, They See 404 Error Pages.
Why?

Usually there are 2 reasons for this error.
1. You enabled Extended Content Protection. If this is the case, disable it at:
Magic Members --> Content Control --> Protections --> Extended Content Protection

= Protections = Downloads = Pages = Custom User Fields

L I

Full Content Protection Settings

Would you like to hide all of your content?
Content Protection ) FULL @ PARTLY ©) NONE

Word Limit for Public Access: 0

¥ Protect your contenis
FULL = Protects contents automatically All Contents will be protected and users have fo login before viewing. [private] tags added manually will be honored.

PARTLY = Protects contents automatically. Part of the content will be free and rest will be viewable after login. [private] tags added manusally will be honored.

NONE = Mo protection will be applied. Any settings in postibage setup and [private] tags added manually will be disregarded unless postbage is set as
FPurchasable.

Purchasable Post will always require login imespective of Content Protection settings.

Extended Content Protection:
Hide Content By Membership @) Yes @ No -tie—
@

Controls wheather posts/page are hidden by current user membership type.

2. You enabled Category Protection. If this is the case, access to the category, edit it and
remove the limitations at:
Wordpress Dashboard --> Posts --> Categories

12. My Site is Slow. Sometimes the Admin Pages of Magic Members
Doesn't Load. What Should I do?

This issue happens sometimes if your site is in a shared hosting. You will need to increase the
memory limit.

Page 98



You can increase the memory limit for Wordpress by editing default-constant.php under /wp-
includes/.

// set memory limits

if ( !defined('WP_MEMORY_ LIMIT")) {

if( is_multisite() ) {

define('WP_MEMORY _LIMIT', '128M");

} else {

define("'WP_MEMORY _LIMIT', '128M");

}

}

13.1 Want To Translate Magic Members. How Should I Proceed?

Details about the Wordpress and language files can be found here:
http://codex.wordpress.org/WordPress_in_Your Language

In order to create a new language translation, please follow the steps:

First of all recognize language code you are creating:
http://codex.wordpress.org/WordPress in_Your Language and full list
http://www.gnu.org/software/gettext/manual/html_chapter/gettext 16.html#Language-Codes

Let's consider Dutch - Nederlands (nl_NL)
the name of GetText (po) file will be mgm-nl_NL.po

1. Download and install poedit.exe http://www.poedit.net/download.php
2. After install copy your version of magicmembers in any local folder i.e c:/wordpress/wp-
content/plugins/magicmembers
3. Open poedit and click "new catalog" in "File" menu
4. a) Project Info - set needed, see sample any po file mgm provides

b) Path - set base path to root of installation i.e. c:/wordpress/ add one more path and set
full path i.e. wp-content/plugins/magicmembers/

c) Keywords : delete all existing and add two new

__and e ( see and po file from mgm)

5. hit ok, save the po file i.e "mgm-nl_NL.po"

6. If paths are ok, poedit will start to scan and load all translation texts
7. edit text as needed

8. Save the po file, it will generate mo file

To edit an existing magicmembers po file;

1. Open it in poedit.
2. Update path ( base path only if mgm installed properly)
3. Update Catalog
4. Edit loaded translation texts
5. Save
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14.1Can't Access Wp-admin. What am I going to do?

This may be a result of incorrect links in Payment/Subscription Settings. Please try to access
your site with the following link:

http://www.yourdomain.com/wp-login.php

After that, access to Magic Members --> Misc. Settings --> General Settings -->
Payment/Subscription Settings and check all the links. Make sure that they correct. Also
make sure that they have www if your site has www in its site link.

15. Export Doesn't Work / Payment Logo That I Uploaded Doesn't
Work. What Could Be The Reason?

Sometimes this could happen due to file permission. Please edit the .htaccess file which is
located at /wp-content/uploads/mgm/modules/ and /wp-content/uploads/mgm/exports/ (you
need to access it via FTP) and add # sign at the beginning of the each line? (You can open
drag and drop into a notepad file to open.)

16. My Custom User Fields are not Displayed on the Registration Page.
Why?

Please make sure you set NO for:
Magic Members --> Misc. Settings --> General --> Would you like to hide custom fields on
registration page?

Would you like to hide custom fields on registeration page?:
In case you select "Yes', the custom fields will be hidden from the new user registration page, but they will be visible in the profile
) Yes @ Mo

o/ ShowMide custom user fields.

17. How Can I Create Coupons and What are the Types?

You can add coupon support to your registration by activating "Coupon" custom user fields.
Magic Members --> Content Control--> Custom User Fields --> Coupon (activate)

[ Birthdate birthdate text Show Edit | System
[ Country country select Show Edit | System
O Coupon coupon text Show Edit | System
D First Name first_name text Show Edit | System
D Last Mame last_name text Show Edit | System

You also have other options to activate the coupon support. In order to activate them, click the
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Edit button.
You'll see the following options:

Edit Custom Field

Label/Name * Coupon

Mame * coupon

o' default lowercase label value, spaces replaced by underscore.

Input Type: Text Field (Single Line) Iz‘
Display/Attributes ! [[] Required:

[[] Readonly

[[] Hide Label

Show On Register Page

[ sShow On Upgrade Page

[[] Show On Extend Page

[[] Show On Past Purchasa Page

o' Display/Usage settings for the fields.

Save » « Cancel

After that you create your coupons at:
Magic Members --> Members --> Coupons

There are 3 different ways to use coupons.

1. 20 or 20% . This applies to all the subscription packs. It drops the price for 20 or 20%.
2.sub _pack#25 1 Y gold

This means, 25.00 USD per year - Ongoing for Gold membership level.

3.sub_pack trial#1 Y 25 1

This means $25.00 USD for the first year, Then $200.00 USD (or what you set for that pack)
for each year. This applies to all packs. What this coupon does is it adds a hidden trial duration
and price to the regular subscription pack. It won't work if you already have Trial setting for
your subscription pack.

Y for year

M for month

D for day

Please note that this special coupon codes don't accept %. You have to write the discounted
price.

18. 1 Would Like To Integrate a Different Payment Gateway with Magic
Members. How Should I Proceed?

You can download the integration documentation and example gateway files below:
http://www.magicmembers.com/files/module-extension.zip

Also, please note the following info (it was for gtbill gateway):

By default all (payment|autoresponder) module follow below mentioned convention
in /modules/payment
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Create a folder by the name of module ( e.g. "gtbill" ).

Inside gtbill create the module main file with prefix "mgm_", this will be "mgmx_" for
modules stored in extend folder which again can be customized via the configure.php file in
extend folder.

So you new payment module will be;

payment/

gtbill/

mgm_ gtbill.php

assets/

html/

/settings.php -- main settings ui

/settings box.php -- quick settings enable/disable

DO NOT load the admin UI until you finish the module variable renaming, if you have copied
a module, make sure EVERY instance of the earlier module is replaced with the new module.
Once you confirm to that then load the UI, otherwise the module will be captured in database
cache and may crash the system due to improper reference, there is a workaround to get rid of
such crash.

If you are on test server, quickly reset the plugin using tools in admin UI -- DO NOT USE ON
LIVE this will erase all setting of the plugin

OR simply remove the module code option from database.

In your case "mgm_gtbill options" and if exists "mgm_gtbill"

To start with the basics, instead of copying a module, create a fresh one with default
overridable methods, as we are continuously working on payment modules, just copying may
cause some trouble if not done properly. Follow the docs to check default methods or the
parent class in /libs/component/mgm_payment.php

19. Math Question is Incorrect in the Registration Form

Magic Members doesn't have math question. It might be Simple:Press Forum's spam tool (if
you have it installed). Please deactivate it at:

Forum --> Components --> Login and Registrations --> Use Spam Tool on Registration Form:

20. How Can I Upgrade Magic Members?

Updates are displayed on Magic Members Dashboard. Once it's available you can upgrade
your plugin in 2 ways.

If you upgrade via Wordpress' Plugin menu:

1. Deactivate old plugin

2. Delete the old plugin

3. Upload new plugin

4. Activate new plugin.

If you upgrade via FTP:

1. Delete the old plugin folder

2. Upload the new plugin folder
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21. How Can My Members Upgrade / Extend Their Account?

Your users can access their Membership Details page to extend or upgrade their account. If
you haven't have Membership Details page on your site, you can create one and use
[membership details] shortcode in it.

22.1 Have Private Tags for All My Posts/Pages. How Can I Remove
Them All?

Since this this is not reversible (it is, but you have to manually edit every post and delete the
private tags). Please install "Search Regex" plugin.

Then access to the plugin.

Source: Post Content

Search pattern: [private]

Replace pattern: leave it blank

Then click Replace&Save.

After that do the same with [/private]
Source: Post Content

Search pattern: [/private]

Replace pattern: leave it blank

Then click Replace&Save

23.1 Have A Different Language Wordpress Installation. When I
Activate Magic Members, I can't Access Admin, What Will I Do?

Please edit your wp-config.php file which is located on the root folder of Wordpress
installation and create your security keys at:

http://api.wordpress.org/secret-key/1.1/salt
Then add them to your wp-config.php file.

24. My Payment Logo Shows Small or Blurry. How Can I Fix It?

When you upload images for payment modules, system auto-resize them. The reason is the
same images are used in the sidebar registration widget.

The thing you can do is, change the image name that you want to use (ex: paypal-button.jpg)
to the image name which now exist (ex:01638600-100x78.jpg) and upload it to :
http://www.yoursite.com/wp-content/uploads/mgm/modules/

And overwrite the file.
There's also a CSS variable that changes the picture's height. You can add the following line to
your theme's CSS file to show the actual image size:
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.mgm_payment_opt customfield image{
height:auto !important;

}

25. My Customer Unsubscribed, But He Can Still Access My Site. How
Come?

If user clicks the unsubscribe button, their account is not cancelled right away. Unsubscribe
only stops the next payments. So, your user will access to your site until his paid duration
ends.

ex: If you have a monthly recurring subscription and your user registers to it. And after 5 days
he unsubscribes.

He will still have access to your site 25 more days, since he already paid. And after 25 days,
his account will be inactive and he won't be charged for the next months.

26.1 Want To Create A Hidden Registration Page For A Specific
Subscription Pack. How Can I Do It?

Please follow the steps below:

Create your subscription pack at:

Magic Members --> Members --> Subscription Options

When you create it, make sure you deselect:

Display Settings --> Active on --> Register page, Upgrade page and Extend page
And select:

Display Settings --> Hidden? --> Hide on General Registration
This will hide the pack from your registration form.

Then, you can use link at:

Package Register URLs/Tag --> Custom URL

or

Package Register URLs/Tag --> Tag

27. Private Tags Are Not Working. What Could Be The Reason?

There are common problems that will prevent the [private] tags from working. The first is
that the tags are not being properly closed. It is critical that you use [private] at the beginning
of the secured content and [/private] at the end of it. REMINDER: Do not forget the slash to
close the private tag.

Another common cause is the <!--more--> tag. If you are using this tag, it cannot be inside of
the [private] tags. If this happens, Wordpress will only read the first private tag, but not the
closing of it. This will leave all of the content visible to everyone because it is an incomplete
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statement and will not be recognized.

Incorrect [private] Correct [private]
<!--more--> [/private]
[/private] <!--more-->
[private]
[/private]

28. Parse Error

What you should do if you receive and error similar to the one below:
"Parse error: syntax error, unexpected T STRING, expecting T_ OLD FUNCTION or
T FUNCTION or T VAR or'}'in
/....../...]...].../domains/yourdomain.com/html/wp-
content/plugins/magicmembers/protected/classes/mgm_xls.class.php(1) : eval()'d code
on line 7

In order to fix this issue, you need to upgrade your server to PHP 5. It's not something we or
you can do (if you don’t have a dedicated server). You should contact your hosting company
and they can upgrade it easily. Usually they have to do these kind of upgrades periodically.

29. Upload Issue in Download Section

If you receive “The uploads directory is not writeable by PHP and therefore anything
uploaded using this tool will fail. Please set the permissions and then refresh this page to see if
you have been successful.” error in download section, please access to WP Admin panel -->
Settings --> Miscellaneous and paste "wp-content/uploads" into the box which says "Store
uploads in this folder"

V. UPCOMING RELEASES

We are always working on improving the Magic Members plugin by adding additional
features and simplifying the integration process. Make sure that you always have the latest
version. Many additions are quickly being added such as additional payment gateway
integrations as well as many enhancements that have been suggested by our users.
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